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Welcome to TopSolid 2024

Welcome to TopSolid 2024

This document presents the main improvements and evolutions introduced in version 7.18 of TopSolid 7. The
innovations described here are only part of the new innovative features incorporated in the software.

To find out what else is new, check our e-learning platform (from March 2024) or contact your local agency.
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What's New in TopSolid'Design 7.18

What's New in TopSolid'Design 7.18

This chapter describes the new features of the CAD applications in version 7.18 of TopSolid 7.

User interface

Dark mode

The Theme section of the Tools > Options command now allows the user interface to be displayed in dark mode to
reduce eyestrain and power consumption.

Preview

200mm

An icon for previewing the document has been added to the new document creation dialog box.

._. New Document (Drafting)

Template:

=

f’"__f Project Templates

f"__f Defaults

=) S
f’"__f My Templates
71! Modeéles Standards Usinage Fil
7 Steel Standard Templates
7] Weod Machining Standard Terplates
f’"__f Standard Templates
il Tooling Standard Templates
f’"__f Modéles standards Qutillage
f’"__f Machining Standard Templates
f’"__f Modéles standards
f’"__f Modéles standards Usinage
f’"__f Modéles standards Métal

Blank Template

O x

r

S ¥
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What's New in TopSolid'Design 7.18

Coordinate display

Cursor coordinates can be displayed from a specific frame using the frame icon located below the graphics area.
Cursor coordinates are displayed to the right of the selected frame name.

200mm

X=+000,000 Y=+000,000 Z=+D00,000 I % Frame Ix:-?m,{:m ¥=+000,000 Z=+000,000

—

History of last documents used

The history of the last documents used is now saved, and these documents can be displayed at the top of the list.
The number of documents to be displayed can be set in Tools > Options > General.

4] Options [m] X
E [:]Manage undeo only on current document
EI Themes
‘i G-Code Simulation Mazximum number of commands to undo per document:
E Display ' 10
E Printing
"~ Analy;l_s Maximum memeory to use for unde per document:
E Rendering
Annotations [ | 1000 ME
k Assembly
&1 Buildings
[é Carn Operator Processors
[15 CAM Options Mummber of unused processors:
|:|:_-_‘ Characteristics
Drafting ' 0
& ERP
¥ Mold
@ PDM Frequently used documents
r‘i_}’i Predefined Values Mumber of documents to show:
¥ Search ' 5
‘ Shape
“§ Sheet Metal
A Sketch Automation
ﬁ Translators
k‘ Walk-through [CJManage remote access This setting requires to restart the application.
£ Wood
= PSS, Bk, o PRS- Y. T, 5. ~a IR P

Hollow Circular Section, 150 4019
"7 DLXXX - Folding Extruded Bar
" Equal Sided Angle, 15O 657-1

;" Flat Section

" Hollow Square Section, 150 4019
" Unequal Sided Angle, 150 657-2

m.ﬂ - Folding Extruded Bar
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What's New in TopSolid'Design 7.18

Licenses

In the Floating licenses tab of the license management window, the Open licenses manager button opens the

Wimadim.exe utility depending on Sentinel to add licenses.

&= Licenses
Protection status

One valid license is available.

Avazilable licenses

Description

Expiration Licensed to

Standalone licenses ” Floating licenses ” Cloud licenses

Mame or IP address of License Server:

‘ Apply Remove

Add a floating license

Commuter licenses
Mazximum duration in days:

7 “

Add license

Refresh

]l ‘When delay expires the commuter license

CpmiEErs e is automatically checked in to License

Server.
Licenses in use

Show license agreement

Toggle on reduced functionalities mode

TopSolid



What's New in TopSolid'Design 7.18

PDM

Project manager

The project management window has been enhanced with search fields and filters for each column.

@ P rojects

O x
Vue [ R @ -
Mame Part Nurmber Creaticn Date Customer
What Y Y Y hd
= ﬁ Projects
T Recycle Bin
G What's New 7.18 27/02/2023
Search
Afilter field is available in the search results window.
s Search Results (980) O >
| Grouping: Drag the columns ento this zone |||Hexa x"
Hexagen Socket MIxB w Hexagon Secket Pan M3 = B w Hexagon Socket Set
Countersunk He... Head Cap Screw GB... Screw with Flat Poi...

Security

Passwords are now hashed in the SQL database, whereas they were encrypted in previous versions. The hash

mechanism ensures enhanced security by preventing the decryption of passwords directly from the information
stored in the SQL database.

Background document

The TopSolid 7 > File > Background Document command features a new button for browsing the current project
tree.

@' Background Document

Document:

| 14

B Transparent

Properties
The Edit button has been deleted from the document properties window. Properties are now directly editable.

TopSolid



What's New in TopSolid'Design 7.18

Archiving

The new Archive command can be accessed either from the context menu in the project manager or directly on a
project in the Others context menu.

‘3 Projects
@ “ Search text
Name Part Number |
v 1
=] :,' Projects 3
T Recycle Bin 3
E& | Internal !
& L | TOPTRACK -
&b W J
g r
ﬂ% What's @ Open
VU Open Main Document
ﬁ Consult Main Document
% Mew Project...
% Delete...
-%_[ Add to Templates...
@3 Export Packages...
= Copy
3 Properties
& Security...
B Archive...

Projects are archived asynchronously and stored in a specific folder defined in the vault management window of
the PDM (Local or Server). Each archive has an identifier recognized by the issuing PDM. Archived project files are
then automatically deleted from the vault.

In the project manager, a new icon at the top right of the window shows the archived projects. You can restore an
archived project by right-clicking on it and selecting the Restore command from the context menu.

W Projects O x
% ﬂ Search text x .;}3['3 @ i
Mame Part Mumber Creation Date Customer
Y Y Y Y
=[] Projects
T Recycle Bin
E& | Internal
& || TOPTRACK
Ea W
& ‘é Examples (archived) a Open ‘
G What's New 7.18 27/02/2023
U Open Main Document
ﬁ: Consult Main Document
% Mew Project...
¥ Delete..
%_[ Add to Templates...
@ Export Packages...
==| Copy
[l Properties
@& Security...
ﬂ Restore...
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What's New in TopSolid'Design 7.18

Multisite

Each time a user connects to a primary or secondary server, files, in the cache vault, whose last reading date
exceeds the specified number of days set by the administrator, are purged This purge is performed asynchronously
to ensure that it does not extend the session startup time. The number of days can be set in the advanced
management of the PDM Server.

The cache vault can be manually purged by the PDM Server administrator using the Purge cache button. In this
case, cache files are purged without regard to the last read date.

TopSolid



What's New in TopSolid'Design 7.18

Sketch

Graphic cut

When creating or editing a sketch, a new icon at the top right of the graphics area allows you to make a graphic cut
to facilitate modeling.

* Sketch 14

Mode

e — 0 B
g \ B
[ Lock

B Interactive

NI ——

Hook deactivation

When creating an entity (contour, circle, etc.), press Shift to deactivate constraint creation or hook on grid.

Offset

The new Lettering mode is available in the 2D Sketch > Operations > Offset command. It can be used to create
parallels between several closed profiles in a very short time.

* Sketch 1

Mode

i
S

Profiles:

||Sketch1 v| |

8 Construction

a il i —_—

The Special Fillets section has also been added, allowing selected fillets to be extracted, kept or replaced globally or
locally.

8 TopSolid



What's New in TopSolid'Design 7.18

* Esquisse 1

Segrnent Type Forced rad...

Esquisse 1:5.. 2mrm

Esquisse 1:5..

Esquisse 1:5..

Esquisse 1:5..

Esquisse 1:5..

Middle profile

The 2D Sketch > Operations > Middle command features the new Circular arc mode, which creates a median
diameter arc from two concentric arcs.

An option is provided to create the complementary arc.

Middle 1 Middle 1

R, U2

First profile: First profile:

o [sketch2 ~| % | |£|Sketch2

Second profile: i Second profile:

A |Sketch 1 | ' ‘Sketch |

Synchronization: / ] Complementary

Free

General mode Circular arc mode

TopSolid 9



What's New in TopSolid'Design 7.18

Silhouette

The new Graphics mode is available in the silhouette’s computing operation. It allows computation to be carried out
by the graphics card, reducing calculation time for complex shapes.

In addition, this mode features an option to perform a silhouette offset, as well as an option to restrict the
calculation to a specific area.

Y * Sketch 1

Calculation mode
() Geometrical

ro Graphical

D Keep inner contours
I Close profiles
[ Check result

Grid size:

1024
B Extent

Automatic extent

Example of a graphic silhouette trimmed by an area.

Rolling up

In the rolling up command, the new Linear conical rolling up mode allows, for example, to obtain letters that follow
the isometric curves of the conical face.

Profiles te roll up:

Sketch 1:Profile(248)
Sketch 1:Profile(247)
Sketch 1:Profile(236)
1:P

Profile origin point:

|Sketch 1:Vertex(3) NE:

Profile ¥ axis:

A | Sketch 13 Axis w | dh

Axial frame:

M—Frame'l V| gh |

© Cylindrical or conical face:

|Sha pe 1:Face(2) R |

Linear cenical rolling up ~

Projected conical rolling up

10 TopSolid



What's New in TopSolid'Design 7.18

Information

When adding information with the Others > Information context command, the information description is now
displayed in brackets after the dimension value, and the comment is displayed when hovering over the dimension

with the cursor.

)

Maximum Length: 90mm

TopSolid
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What's New in TopSolid'Design 7.18

Shape

Pocket

When the pocket contour contains concave and convex portions, you can now specify different fillet values.

=
@ Blend and Fillets

Blend

Type:

Mone

Fillets

Bottom radius:

o

Internal vertical radius:

ISmm

External vertical radius:

IEmm

3D threading

The Model option is now available in the drilling (tapped hole) and threading commands. It allows you to create the
actual shape of the tapping or threading for 3D printing.

Threading 1

Face to thread:
|| Forme 1:Face(117)

Origin plane:
A Plan 1

Complete threading:

O |False
Length:

1dmm

B Model
General Advanced

@ standard:

Square Threading

[ Strict

Description:

M20

12 TopSolid



What's New in TopSolid'Design 7.18

Offset
The dialog box for the Offset command now includes a new section for manually excluding faces.

Moreover, the Detect faces to exclude button automatically deletes faces that cannot be offset.

Faces To Remove

Faces To Exclude:

Handle:Face[391)
Handle:Facel377)
Handle:Facel320)
Handle:Facel305)
Handle:Facel277)
Handle:Facel291)
Handle:Facel461)

05)

Detect Faces To Exclude

(O Create Boundary edges

TopSolid 13



What's New in TopSolid'Design 7.18

Surface

Face copy

In the Surface > Faces command, the new Apertures section allows you to copy a face in restricted mode without
taking holes into account.

e Apertures

B Cover the apertures

[ Apertures tc ignere:

Removing

The new Bodies to remove and Bodies to keep modes are available in the removing command. The Bodies to keep
mode can be very useful when you want to keep only one body from the shape.

Y Removing

Type:

BRI AR

() Bodies to remove
Bodies to keep

[JKeep bodies

14 TopSolid



What's New in TopSolid'Design 7.18

Sheetmetal

Sheet metal on sketch

In the Sheet Metal on Sketch command, the new advanced Fast flat shape option significantly improves creation
times for sheet metal on sketch in the Flat shape mode. This can save up to 80% of time in the case of a sketch
containing a large number of profiles (a grid with holes, for example).

This option is checked by default in the command.

B Fast flat shape I

Improved sheet metal properties management
Sheet metal properties management significantly boosts performance, reducing calculation time by up to 80%.

To benefit from this optimization on old files, just regenerate the operation named
Sheet Metal Properties Management.

Wee L@ £ 3 I8 Sk T g b7 @ of 3 [ 18 SR
S | S |
14 .= Analysis Stage AL .= Analysis Stage
TA4L C_.. Sheet Metal Properties Management 1,37} i rv Sheet Metal Properties Management
U007 @ Threadings Management U007 - @w Threadings Management
0,70) i % Physical Properties Management 0,70 i “* Physical Properties Management
0,00 i «® Enclosing Box Management 0,00 . «|” Enclosing Box Management
0,00 - % Fibers Managerent 0,00 i %% Fibers Management
0,00 i s” Extent Management 0,00 .. " Extent Management
0.00 -1 0,00 i-f ..
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Assembly

Extruded bars

When installing extruded bars, three new icons at the top right of the graphics area allow you to make a graphic cut
to facilitate positioning.

In the Modeling menu, the Miter Trim, Main Trim and Trim commands now integrate a preview of the result.

Extruded bars:

Hollow Square Section 10(
Hollow Square Section 10(

[ Hide

B Extend
¥
Offset:

|{J,Omm

[ Variable angle
(O Create folder

The Variable angle option has been replaced by five icons to manage trims between complex extruded bars.

Basic extruded bars Inside trim Outside trim

16 TopSolid
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The Modeling > Planar Trim command has been renamed Trim and now offers four trimming modes:
* Trim by plane
* Trim by surface
* Trim by faces
* Trim by profile

New handles are available:

* The yellow handle is used to select the portion to be retained. In previous versions, only the longest portion
of the extruded bar was retained.

* In ambiguous cases, like the trimming of an extruded bar passing through a cylindrical face, yellow and red
spherical handles allow you to choose which side of the cylindrical face to use.

Note that these handles are also available in the Modeling > Main Trim command.

Examples of profile trimming with the new handles.

The Trim command also features three new straightening modes.

=

None Straight Tangent

Extruded bars imported and converted via the Modeling > Sheet Metals Recognition command are now supported
by extruded bar trimming commands.

TopSolid 17
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The new segment-based positioning mode automatically performs the following operations:

18

* positioning an extruded bar on the selected segment;

Family:
| : Equal Sided Angle, [SO 657- v|

Code:

F\/*"WIJ‘JE

Destination segment:

Adjustment

Orientation:

180°

D Invert

create a cut by box with the length of the selected segment and the dimensions of the extruded bar section;
create a cut by plane passing through the selected point on the segment;
orientate the camera normally to the cut;

zoom in on the section.

TopSolid
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Division
The new Division command is available in the Modeling menu. Similarly to a part document, it can be used to
divide a part or assembly into several parts.

Section:

Sfewmer o

Areas to keep:
Exterior

Distribution
A number of modifications have been implemented in the component distribution command:
» As with extruded bars, three new icons at the top right of the graphics area facilitate graphic cuts by box

streamlining the positioning process.
» Two modes for selecting the number of components are now available at the top of the dialog box.

by " (-l"
W

@ Distribution

i1 |l&

|_\ . Twe components mode |
*

Destination frame:

* In the Second component section, the Link the second component positioning with the first one option
applies the same settings (orientation, inversion, offset) as those defined in the First component section.

* The numbering type choice has been added to the Advanced Options section at the bottom of the dialog
box.

TopSolid 19
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Advanced Options

B substitutable in upper levels

Mumbering:

|Ascending with stable extremities

Alternate Ascending

Alternate Descending

Ascending

Ascending with stable extremities

Example of ascending numbering with stable extremities.

* In the Tools > Options > Assembly command, the new Distributions section is used to define
default values for the Link the second component positioning with the first one, Numbering and
Modified component for the remainer options.

[M Opticns

s General
E Themes
E Display
E__ Printing
7 Analysis
E Rendering
Annotations
= E Assembly
E General
[N Distributions

: Extrudei Bars

B Always link the second component positioning with the first one.,

Mumbering:
Ascending with stable extremities ~

Meodified compenent for the remainer:

Second w

P oy

P Sy

A e e

Unsynchronized operations

You can now regenerate a selection of unsynchronized operations from the Operations tree.

Occurrence properties

It is now possible to replace the system properties present in definition documents. This allows you, for example, to

modify the description or part number of a component included in the assembly.

20

Property Value
Description Extruded Bar 40x3
Mass 2kg

Material Description || Aluminium

[ Mame

TopSolid
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In addition, the Occurrence properties section has been added to the Tools > Options > Characteristics command.
This allows the modification of the properties of a part's occurrences from a bill of materials displayed in the Parts

tree or from the Tools > Character

istics command.

4| Opticns O %
i General Documents:
5 e Fou
-j Display
=, Printing Available characteristics:
"F AﬂalYSI.S Search Chosen characteristics:
.j Rendering
Annotations Classifyings Occurrence properties
h Assembly = Occurrence properties Add of a new property...
& Buildings Add of a new property...
[ Cam Operator Options
s CAM Options Physical properties
EF-‘ Standard properties
Drafting User properties

Subcomponent processes

Subcomponent processes are now carried out automatically.

Local shapes

The Local Shapes sub-menu has been renamed Shapes and the commands for creating surfaces and sheets have

been added to the Surface and Sheet Metal menus.

Pipe...
Swept...
Lofted...
Fitting...
Filled...
Constrained...
Blend...
MNarmal...
Faces...
Middle...
Flat...
Matrix...

Surface by Formula...

Extension Surface...

Tangent Surfaces...

s AN EI (e litPRAE&ELW

Imnprint...
Remaoving...
Fill Hole...

Extension...

L=

Smoothing...

Menu Modeling > Surface

TopSolid

WdVNIAY {8A4D

Transition Sheet Metal...
Flange...

Hem Bend...

Covering...

Unbending of Bend...
Rebending of Bend...
Corner Relief...

Edge Relief...

Lateral Faces Straightening...
Ferming Flange Straightening...
Surface Sheet Metal...

Menu Modeling > Sheet Metal

21
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Replacement

In the Replace section, check boxes have been replaced by buttons which pre-fill the list of selected elements, giving
a preview of the elements to be replaced.

Replace

() This component

© Several compenents of this family

With code CH 220 = 29

All codes

Poutrelle en U section CH 220 = 29 <
Poutrelle en U section CH 220 = 29 <
Poutrelle en U section CH 220 = 29 <
Poutrelle en U section CH 220 = 29 <
Poutrelle en U section CH 220 = 29 <
Poutrelle en U section CH 220 = 29 <
Poutrelle en U section CH 220 = 29 <

Poutrelle en U section CH 220 = 29 <

[ Hide

0 To equivalent code
Rt

Py — i e e R - —— 2

Replacement wizard

In the Replacement Wizard dialog box, the choice of Redirect Hooks or Replace Geometries modes has been
removed. The default mode is now Replace Geometries.

However, it is possible to re-display the choice of modes by starting TopSolid in obsolete mode. To activate this
mode, add the "-0" argument to the launch shortcut.

Local parts and assemblies

Symmetry of local parts and assemblies is now supported.

In addition, the context Provide Function command is now available on a local part or assembly. This allows you,
for example, to define the nesting characteristics for a local part.

22 TopSolid
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Building

Staircase layout

Height to cross

The Height to cross information is now available and can be set in the graphics area label. It is possible either to
enter a length, in which case the value can be edited in the graphics area label, or to select a point in the graphics
area, in which case the height cannot be modified.

Winder staircase with short flight length
When creating a staircase with a winder landing, the collar of the treads increases progressively as moving away
from the change in direction.

With the new version 7.18, the minimum collar is given to the first treads if the flight length is sufficient; otherwise,
the minimum collar is only applied to the first tread of adjacent flights.

M

The minimum collar is only applied to the flight permitting.

N

|

In version 7.17, the above case could not be created with a collar value other than 0Omm.
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Modify 2D layout

The new mode Modify 2D Layout, accessible via the % icon in the graphics area, allows you to locally modify a
tread on the 2D sketch. When this mode is activated, it is possible to select a tread segment and rotate it around the

treading line by moving the yellow spheres.

1%

In the example above, the first tread has been modified.

The exception is marked violet.

Stringers
The new Stringers section allows you to create sketches and local shapes for stringers.

Sketch for central stringer under treads Local shapes of stringers under treads Local shapes for lateral stringers
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Staircase treads

Family driving

The Center Right Angle driver has been added to the Tread family driving family for T7 type. This means more

tread geometries can be matched to the T7 type.

What's New in TopSolid'Design 7.18

350 (LefiDepth)
120* (CenterLeftAngle)

T
30° (FrontBackAngle)
110° (FrontLeftAngle)

I- } 1000 (FrontWidth)

100 (RightDepth)

/

/110" (CenterRightAngle)
e —

50 (BackRightDepth)

Apply to all types

The new context-sensitive Apply to all types command is available from any line in the treads table. It applies the

parameters (family and drivers) of the current line to all compatible types.

Modeling

Marking

Font instances used by the marking command are now referenced; these are exported when the document is

exported and cannot be purged if used by a marking.

TopSolid

Pararneters
Type Family:
1
| " Tread 52 - Wooden Tread with Riser V|
3 Apply to all types l
4
5 Tread || Riser ” Advanced Qpticns |
] Riser:
] |True w |
Riser Thickness:
|1 Smm
o
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Workspaces

Menus

In a Workspaces Manager document, the Shape and Surface menus have been simplified and the
Construction Shapes command has been added to the Construction menu.

Creation

Workspaces can be created directly from the context menu on the Workspaces folder of the Entities tree.

Entities a1 X
T e (o) 2o (7 1B 20 ?
%o % % @

1 Contexts (0)

@ "
Ty Represent Selection
3 Constrain i Workspace... I,\\S
Ty Parts (1)
Ty Shapes (3)
Ty Cameras (4

dx Compass
9 Frames (1)

Workspaces
Others »

SR &l

In the creation dialog box, the new Contexts check box allows you to select or deselect all contexts.

Author:
Admin

@ Contexts: |

[#]|2nd Level Walls
]| Balcony Slab1
[+] | Balcony Slab2
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Copy of workspaces

What's New in TopSolid'Design 7.18

The new Copy workspace context command can be used to duplicate a workspace with its background document.

It facilitates, for example, the creation of several versions of the same workspace.

I e~ |EF el 2o (7 Ee 20 e ’3

Assembly

| o6 88 W6 [
| T Contexts (4)
= ‘q} Workspaces (3)
o
g W5 Workspace (W53)
g WS % Edit...
i1 Repres Others
[y Constr T
W] = Parts (1] Edit
1 iy Shapes A e
iy Camer Delete
| 42 Compa @ Assemnble Workspaces...
L ) Frames G Copyworkspace...
S g ‘I:I:ne(sa % Force Update Workspa%
es
O i Points “U  Open Document
[y Parame Others

i Styles (4)

Similarly to the workspace creation command, the workspace assembly command features a new check box for
selecting all contexts and workspaces with a single click.

TopSolid

@: ) Assemble Workspaces

© New final assembly

|Fina||

Update final assembly

] Workspaces contexts:

]| 2nd Level Walls

[+] | Balcony Slab1

[+] | Balcony Slab2

B Workspaces:

ws2

W53

]
]

27



What's New in TopSolid'Design 7.18

Method

A method is used to define a sequence of operations and apply them to an element of a Part or Assembly

document. This allows you, for example, to create a rectangular pocket with drillings on each vertex simply by
dragging and dropping a Method document into a Part document.

This new document type is available in the Advanced tab of the document creation window. It functions similarly to
the Family document.

¢’|_| New Document

Type:
| Commen ” Advanced ” Special

Template:

;’ Family
.._'i? Family Driving
I.? Filter
2 Laminate Material

% Material

Q Multilayer Material

, Part Functicn
E' Part Process

? Plastic Flow Analysis Preparation

E‘ Project Templates
E‘ Medeles standards Métal
E‘ Medéles standards
E‘ Steel Standard Templates
E‘ Machining Standard Templates
E‘ Modéles standards Usinage
E‘ Teoling Standard Templates
E‘ Medeéles standards Bois
E‘ Medeles standards Cutillage
E‘ Weod Standard Templates
E‘ Standard Templates
E‘ Wire Machining Standard Termplates
E‘ Modeéles Standards Usinage Fil
E‘ Weood Machining Standard Templates

&% Search E‘ My Templates
Texture T IaTera - »

s, _._.l.-.s.

e e

Aadi aal

s

When the method is applied to an element, the operations are recreated on it without creating a link to the method.
They can therefore be modified independently.

.l Stert Page |[7 PocketWithHoles

B e 123 el 2o (3 [E 24 [ ?
[m] % Geometric Generics

9 Generics
[m] I3 Drivers

[ % Operations
W Angle Clearance 1
a Repetition 1
",-_" Symmetrical Pattern (Motif 1)
3 Middle Plane (Plan 2)
; Middle Plane (Plan 1)
@ Drilling 1
<L Constrained Frame (Repere 1)
* Pocket 1

=i

9 Parameters
T3 Backgrounds

28

When including the Method document, all operations framed in red are automatically recreated on the destination shape.
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Bill of materials

Index rules

What's New in TopSolid'Design 7.18

Index rules are no longer defined solely in relation to Function documents. They can use Filter documents to define

the parts to be considered.

It is also possible to define a default indexing for parts that do not correspond to any of the defined rules.

[ =
= Index Rules

T —

Add

Default rule:

P500

%

Remove

N

(]

X

Designation:

Fastener

Activate  Filter document
Building

Curved Extruded Bar
Extruded Bars

Glass Material
Has a Coating Area
Has Bends

Manufactured

Mineral Material

o o S o

Multilayer Plate

Fasteners

Imported Extruded Bars and Non-sheetmetal Extruded Bars

Keep entities  Ignore occuren...

Qoooooo®oon

OoOooOoOoogoono

Family

Index

» I

v R ?

In addition, the two new Assembly Type For BOM Rules and Part Type For BOM Rules commands allow you to

change the value of the Type for BOM parameter in the bill of materials only.

Property filters

Properties assigned to part occurrences are now supported by property filters.

Manufacturing indexes

It is possible to obtain a list of modified manufacturing indexes by displaying the new property

Previous Manufacturing Index in a column. Similarly to the manufacturing indexes, these indexes can be reset via

the Bill of Material > Clear Previous Manufacturing Index command.

T
il Columns

Available properties:

Search

Ly

Selected columns (ordered):

(m]

X

| Selected column ” Sorting column |

Classification
Function
[=I Standard
Bending
EIBill of material
Image
Index

Mounting Index

Dimension
[ Electrode

TopSolid

Manufacturing Index

Previous Manufacturing Index

[ Manufacturing Index (Bill of material)
(3] Quantity (Bill of material)

:L:j Description (General)

:;| Material Description [Material)
[ Ceating Description (Material)
:L:J Mass [General)

:;| Length (General)

:;| Trimming Angle 1 (Design)
[ Trimming Angle 2 (Design)
[ Complex Trimming (Design)
:;| Image (Bill of material)

Forced column title:

Visible
Indented
Level

From current level

+ @

)
y
;
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Visualization

Cut by box

The new Cut by box command in the Visualization menu allows you to create a graphic cut from the element
bounding box.

Cut by Box

Mames:
|Cu‘t 1 |

O Frame:
| A |Absolule Fram v| L |

() Origin:
| b

Advanced Settings

@ Options

8 Display cut
8 Use shapes color
B Automatic hatching

8 Display cut edges
(O Preview cut edges
[ Cut sketches

@ Activate cut

Example of a graphic cut by box.

Realistic rendering

If no rendering camera is present in the document, the Visualization > Realistic Rendering command now
proposes to create a rendering camera when it is launched.
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Studio

Scattering volume

The new Scattering Volume command is used to define a volumetric effect. This matches the effects induced by
light passing through particles like gas, smoke, dust, etc.

Without scattering volume With scattering volume

Analysis

Area

The Analyze command can now be used to display the area of a pocket MF.

MF 5
(Pocket MF)

Attribute
Color: R=255 G=255 B=255 (White)

Geometry 4
Direction : X=0 Y=0Z=1 )
Depth : Smm ]
Is Through : Mo

ls Open : Mo

Bottom Radius : Omm 3
Vertical Radius : Omm
Taper Angle: 0°

Area: 2035,513262mm2
VBTITE T TS TImms
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Construction

Color parameters

The Color Parameter, Table Color Parameter and Switch Color Parameter commands have been added to the
Construction > Parameters > Other Parameters menu. They can be used to set the color of an element in the
Material, Coating and Finishing documents. The parameter created can then be used as a driver in a Family

document.

Combined pattern

The Construction > Patterns menu has been enhanced with the new Combined Pattern command, which allows
you to multiply and sum multiple patterns.

Example of a multiplication pattern combination (right) from two circular patterns (left).

In addition, the new Construction > Patterns > Pattern Optimization command can be used to modify the order of
pattern occurrences in order to control the machining path.

MNumber of points: 1411
Path length: 2,369m
Calculation time: 25ms

MNumber of points: 1411
Path length: 2,336m
Calculation time: 21ms

Advanced Options Advanced Options

Repeated point: Repeated point:

L L

B Modify numbering

B Modify numbering

Example of pattern optimization from different modes.
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In addition, the Analyze command is now available in the context menu, providing the number of elements in the
pattern.

MNarme:
|Motif1

Infarmations:

Total number: 381
Displacements by translation: 830

Repetition
The Repetition command’s performance has been improved.
For example, repeating a point in a 100 x 100 matrix pattern now takes just 2 seconds, instead of more than 20

seconds in previous versions.

Intersection point

You can now create an intersection point between a profile and a shape. This ensures greater point stability when
the shape is modified, or when the intersection point is likely to move to another face on the shape.

-, . .
a4 Int t Point
. ‘ ntersection Poin

Mame:

Paoint 5| |
Maode J—
i &> D

First geometry: Profile/Shape

Plane

When hovering over a plane, modifiers are now displayed at the corners and on the middles to change the size of
the plane.
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Frame

Fields for adjusting the size of frame extremities are now available in the frame style dialog box or when creating a

@ Style de repére 1

frame.

BOM index

Mame:
|Sty|e de repére 1 |

(O Current style
Base style:

Oz length:

100%

X Size:
l200%

@8 v size:
l200%

@ 7 size
l200%

Axes colors:

| X | %X | X

The new Construction > Parameters > Bill of Material Index command allows you to define the bill of material
index for the part or assembly. For example, this allows you to retrieve this index in the document name using the
[$BOMIndex] property.

Construction shapes

When creating or editing a construction shape sketch, the new Height and Offset context command can be used to
force the height and/or offset of each construction shape in the sketch.

34

Construction Shapes Sketch 1

Solving (Construction Sha...
Others

Construction Shapes Sketc...
Others
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Point cloud
On a point cloud, the new Section context command isolates a slice of the point cloud by indicating two planes or a

box. A mode allows you to either keep the points or to rebuild a contour.

Section

Paint cloud:

|PointCIouds‘I

Mode
O Points
() Centour

(e

Selection distance:

100mm

Position

TopSolid



What's New in TopSolid'Design 7.18

Tools

Annotations

In a 3D document, the operation of the Tools > Annotations > Dimension command is now homogeneous with that
of the Detailing > 3D Dimension command from a Drafting document.

The dimension plane is determined automatically and can be modified manually using the Change plane button or
the Ctrl + Space keys on the keyboard.

In addition, the Drilling Note command has been added to the Tools > Annotations menu. Similarly to a Drafting
document, this command facilitates the retrieval of drilling information.

Derivation

Block envelopes are now proposed in the dialog box of the derivation command.
.’l WY
Entities to derive
B roints
8 Axes
B Directions
B Planes
B Frames

B Block envelopes

Processing parts and repeated processing parts
The Create Process and Processing Parts commands have been moved to a new Processes sub-menu.

This sub-menu also contains the new Processing Parts Repetition which allows you to create processes for a
component, repeat it and define the result as a processing part.

This new command boosts performance by at least 50% (test carried out with a component containing a repetition
of 247 screws).
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Set

What's New in TopSolid'Design 7.18

The Edit, Attributes and Show/Hide dimensions commands are now available in a set's context menu.
B & [0 a=| el 2o (75 20

Company options

6| o6 88 W (i) !
®| = Sets(1)
m = s
5 ﬁ Shape 1
DI - N—
& H @ Sket | Selection i
i[9 Representat t(3 Folder
M| @ 6y Shapes (1) Others R
[m] g Eketches g Set 1+ Sketeh 2
ameras
5] $n Compass W Delete !
Cd [y Frames (1) Others 5
| =y Planes (3) Solving (Sketch 2)
L 2@ MG “b Edit.
L = Points (1) o h’
3 Parameters = »
i Styles (8) Sketch 2
{-LG Show
£5  Hide
N‘: Hide Dimensiocns
(Y Attributes...
Delete

PR Y

P R W

ol

The Predefined Values section can now be accessed via the Tools > Company Options command.

TopSolid
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Materials and textures

The user interface for the Material, Coating and Finishing documents has been improved:

* The Common tab has been renamed Appearance.

* The Advanced tab has been renamed Properties. It also contains the BOM information (description, part
number, category, etc.) of the document.

* Rendering can be previewed with the help of a sphere in the graphics area.

In addition, it is now possible to use parameters in the fields, which can then be driven in a Family document.

Nesting (optional module)

Integration of lead in/out geometries

In the case of nestings of machined parts, the lead in/out geometries are now correctly taken into account by the
nesting or collision checking.

Moreover, collision management between these geometries and parts has been improved.

Bar nesting

Simplified dialog box

The Parts and Supports tabs have been lightweighted, and the Section, Material and Thickness columns have been
removed as unnecessary.
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Drafting

View

What's New in TopSolid'Design 7.18

The new Project joined parts definition option allows you to draft the part as defined in its generic document, but
with the dimensions after inclusion in the assembly.

Cross section

,, Set (Main Set (Assembly 2))

Source document:

| & Assembly 2

Representation:

Detailed Representation

(0 Representation

O Entities

B0 & Assembly 1<153>
OF Part1<154>
I Part2 <156>
O Part3 «158»
OF Part4 <160=

B Project joined parts definition I

Main configuration:

Auxiliary configurations

In the dialog box of the View > Cross Section command, the Geometry field is no longer mandatory when the
Depth option is checked. This allows a cross section to be performed with only one additional depth.

Bill of materials

The Open Document command is now available in the context menu on a BOM table or on a BOM index in the

Entities tree and in the Operations tree.

Hatching

When modifying a hatched area, the new All occurrences option allows modifications to be applied to all hatched
areas (in all document views) of all occurrences in the same part.

TopSolid

v R ?

@ Definition

| 8 a0l occurrences |

Type:

mn.‘pm‘-_-_‘
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Drilling note
In a drilling note style, it is now possible to retrieve the point depth.

This value can also be defined from the drilling note creation.

Hole

ey s B 1 U e xa 3 BB X =

I
o)
i®
Ba | x

Symbols

Texts 4

Reals 3 Toleranced value:
3
3

e A P —y

Others Hole total depth
: Repetition diameter
] |

F o S v— P ey PP R

Tables

Table position
The table creation dialog box has been transformed into a wizard.

The Create table in another document option positions the table to another document, whether new or existing,
with a different paper format. This option is available in coordinates tables, drillings tables, dimensions tables and

bends tables.

In addition, the new Detailing > Tables > Table As command can be used to create a copy of a table in another

document.

L
L

j Drillings Table

Wiew:
|“u’iew‘|

Style:
Merged cells

Index style:

Drillings Table Index Style 1
Drilling note style:

Drilling Mote Style 1

B As table

B Create table in other document

Drillings table
Several improvements have been implemented in the drilling table style definition window:

* The window can now be resized.

* Grouping options have been moved to a drop-down list.

* A new information search field is available.

* The new Merge identical values option allows you to cluster cells with similar values.

40
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1) Merged cells

What's New in TopSolid'Design 7.18

Mare:
|Merged cells |
B Current style
| Columns || Predefined groups ” Configuration || Identification
Grouping: By axis w
Awvailable information: Selected information: Column
B Visible

Search x

=1 Drilling information
Additional Text
Bottom angle
Bottom radius
Bottom type
Comment
Depth type
Diameter
Helix sense
Minar diameter
MNeminal diameter
Number in the group

Mame
Index

Symbol

Diameter: Effective value: Automatic

Telerance: Diameter: Effective value: Automitic

X coordinate

¥ coordinate

Altitude

Woerk depth: Depth: Computed value: Effectivélalue: Au

J
v \’
Grouping criterion: | B Merge identical values

Infarmation for serting:

FT

O MNew column

C] Column title:

) Merge column

Separation text:

Insert line return

LA_—---A et et i, i o T 0 o b b bk e e o ot ek

Pitch (J Prefix:
[ Semi angle
SPOT FACING 10 | SPOT FAOING - 18MM 10.5MM 18 105
HOLES HOLE L 11MM Z16MM X 166MM THROUGH 1
[
le[;?E_I;AEINEB SPOT FAOING l :?:: 216MM X 30MM 10.5MM 1118 10.5
HOLE® HOLE ! MM 176MM X 126MM OMM THROUGH 8
[ &
SPOT FACING 5 SPOT FAOING 18MM 30MM X 166MM 10.5MM 18 105
HOLE 4 HOLE L 11MM THROUGH 11
HOLE 3 L MM F0MM X 70MM ]
SPOT FACING 2 SPOT FAOING - 18MM 10.5MM 18 105
HOLE 1 HOLE L 11MM S0MM X 0MM THROUGH 11
NAME TYPE SYMBOL | DIAMETER COORDINATES ALTITUDE | WORK DEPTH NOTES

In addition, the following modifications have been implemented:

* Entry points defined during pocket creation are automatically retrieved.
* Itis now possible to retrieve the nominal, maximum, minimum or average value of a toleranced value.
* For derived parts, the Automatic mode retrieves values according to the defined mode (nominal, maximum,
minimum or average) in the Tools > Derivations > Redimensioning command.
* The depth can be either theoretical (value input when creating the drilling) or computed (when drilling
through a cavity).

TopSolid
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Dimensional tolerances

In the Special tab of the document creation window, the new document type Dimensional Tolerance Standard
allows you to create your own linear or angular tolerance standards.

£
" | New Document

Type: Template:
| Common ” Advanced ” Special

.Ij Classification

l_l Clearance Hole Standard

f’__j Project Templates
f’__j Maodéles standards Métal
f’__j Modéles standards
Cut Technclogy Z;' Steel Standard Templates

. . . | Machining Standard Templates
5~ Oylinder Margins Rules %’_j Modéles sgtandards Usinase
f’__j Tooling Standard Ternplates

Dimensional Tolerance Standard

]

E'f Enumeraticn f’_J Modéles standards Bois
= . (’_J Muodeles standards Outillage
U7 Environment = Wood S 2 Temola
2 P A 2l B it r i . o

Dimensional tolerance standard document creation.
My Standard Length Tolerance

Dimensicnal tolerance

s

Telerance value type:

1
Linear ~ 1‘
Unit type: ‘
[

Length
Value = Omm Value = 3mm Value > 10mm Value > 20mm Occasional usg

1
0,00mm-0,00mm | 0,02mm;-0,028mm | 0,03mm;-0,03mm | 0,04mm;-0,0dmm [l

0,015mm;-0,015mm | 0,025mm;-0,025mm | 0,035mm;-0,0353mm | 0,045mm;-0,0453mm [l J

s oy I S -y ™

Dimensional tolerance standard document example.

These standards will be visible in the Tolerances section of the dimensioning commands.

v ) ? .

LA )

B Tolerance

\ Type: —n
Standard ~

o | Standard:

|@ My Standard Length Tolerar -

Symbol:

Lo w

jati i5|

Use of dimensional tolerance standard in dimensioning.
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The icon for special inputs is how available in the Composite Dimension and Automatic Composite Dimensions
commands.

@ Composite Dimension

Mode:
= o= 10, ==
Bl T T
Direction:
Vertical w

Origin geometry:

| %
Measure geometries:
%]
Selection

M Extreme Point...
- Intersection...
Midpoint...

Style:

Composite Dimension

Dimension Style:

Dirmension Style 2.3

Automatic composite dimensions

The new Dimension extremities for horizontal and vertical lines option is available in the Detection section of the
Automatic Composite Dimensions command. It selects the vertices of all horizontal and vertical lines in one view.

YWayy

a: Cylindrical face detection
Maximum tilt:

0

Minimum arc:

360°

Maximum diameter:

1000mm

Minimum diameter:

Ormm
[_] Take side axes into account

] 2 Vertices detection

[ lgnere extruded bar extremities

25 40

35

caa |

15

10
,i\

25

B Dimension extremities for herizental and vertical lines

(2

e e R T =

?
5

— —

In the above example, the detection of the extremities of the horizontal and vertical lines automatically dimensions the oblong hole.

TopSolid
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QR code

The Detailing > Text and Sketch > Text commands (Part and Drafting documents) feature a new option for
converting text into a QR code.

Format

(] Justification:

CFont:

lsonorm D 2,.5mm

O Layer:

B CR Code:
0 Ves ) Ne
Size:

12mm
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f - —
{ Description: Author: Admin
' A3
f - Date: 26/09/2023
; Part Number: ____ Scale [Revision| Folio 1
f - g 1,30:1 A 11
t - =ik =] Project:
1 ; EQSOIId ; What's New 7.18
! [ )
[ [ [ [ I ‘ A

TopSolid




What's New in TopSolid'Design 7.18

Unfolding

Automatic flip over in case of imprint

When manually creating an unfolding or when generating multiple unfoldings using the matching command or
an unfolding process, the origin face is automatically selected by TopSolid. Previously, this referred to the largest
planar face on the part, or otherwise the largest developable face.

Now, if the part has imprints on only one side of the sheet, this side is given priority for the selection of the origin
face. The Turned over mode is automatically activated for positioning the unfolding. This guarantees the inclusion
of imprints in the unfolding, positioned in the correct orientation for drafting or machining.

Inaccessible imprints

The new Inaccessible imprints option is available in the advanced options of the Unfolding and Unfolding Style
commands.

When this option is checked, the unfolding becomes invalid if:

* the sheet has imprints from both sides;
* the sheet has imprints on one side only, but the original face is selected on the opposite side.

£®) Advanced Options

B Advanced opticns
Dressing
B Tapping
[T Facing and csinking
aiie S NV
L =T W T - W S Ve
Invalidity cases
[[] Presence of complex formings
[ Presence of guasi developpable faces

[ ] Open external profile

_Hlnaccessibleimprints

[ Chamfered lateral faces

Angular tolerance

Chamfered lateral faces

In the advanced options of the Unfolding and Unfolding Style commands, the new Chamfered lateral faces option
is available for invalidity cases.
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When this option is checked and the sheet has chamfered lateral faces on the original face side, unfolding becomes
invalid. This prevents the generation of too short unfoldings because of chamfers.

Multiple unfoldings

Advanced Options

B Advanced options
Dressing
B Tapping

O Facing and csinking

Invalidity cases

|_I Open external profile

|_IInaccessible imprints

T s ¥ i i O S, S WOV R e

|_| Presence of complex formings

| Presence of quasi developpable faces

Angular telerance:
5e

B Chamfered lateral faces

The search for existing unfoldings or draftings to be updated now accurately identifies the unfoldings generated
on the occurrences. In addition, if there are no existing unfoldings or draftings to be updated, the corresponding
options are grayed out.

As with multiple draftings, two new options are now provided for deleting unnecessary unfoldings or draftings.
The eligible documents for deletion include unfolding or drafting documents located in the specified destination
folders that are not part of the documents to be updated. These options are automatically disabled if no candidate
document is detected or no folder is specified.

46

=) Multiple Unfoldings

Selection: Manual

[ Assembly 1
[ 02 - SheetMetal Part - & |dmm
] 02- SheetMetal Part- ¢ | dmm

Source Thickn...

Mater... Existing Unfoldin.. Templ.. Existing Draftin.. Creati.. Drafting Template

Acier Acier - 2mm - (x1)2 | Mise a p... |03
Steel Acier - 2mm - (x1)2 | Mise a p... |01

|
-Tole-ep2 [ |Tole pourliasse de plans
-Tole-ep2 [0 Tole pourliasse de plans

B with draftings
Destinatian

(O Source folder

© Specified folder: WINTSS.. 55778401

Options
8 Open after creation.

L] Update exist unfoldings.
B Delete useless unfeldings

B Urfold oceurrences

© All occurrences

() Occurrences of the instance families

Destination of draftings

() Source folder

OSPE(mEdFD\dEr e V155, 1557701

Drafting options
8 Open after crestion.

] Update existings draftings.

B Delete useless draftings

v?x
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Transformation

What's New in TopSolid'Design 7.18

The Sketch > Transform command features the new By direction and distance mode.

@ Transform

Vol g o
Py !’_;'

V. Vs

Direction: By direction and distance

| A |sketch 1:5egment(s) |

Distance:

|5'Dmm

Work document and Work manager

Update

When new parts or assemblies are added, or when repeat quantities are changed, the documents created by a
work document can be updated when running the program again.

Moreover, it is now possible to assemble documents of the Unfolding type.

Exports

In document export tasks, a drop-down list now allows documents to be exported either to a PDM folder, to an
external folder, or to both.

In addition, two tabs allow you to choose which representations to export. These are also available in the
Export Several Documents with Conversion command window.

| Advanced configuration

*

Only export

Only add to Pdm
Export and add te Pdm

Export folder...

Source folder

Design document representation

|| Unfolding decument representation

Current

TopSolid

Verzion:

AP214

- Maming convention
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2D modeling

Parameters, points and frames

To facilitate the creation of parameterized symbols, the following commands are available in the Construction
menu from a 2D model document:

 Cartesian point, Polar point, Point on profile, Extreme point, Intersection point and Projected point
* Angle parameter, Distance parameter, Distance in direction parameter and Length parameter

* Axis by point and direction, Middle axis, Offset axis, Pivoted axis and Orthogonal axis

* Frame by point and direction

Interfaces

Spatial translators

An explanatory message is now displayed when the Sewing faces is checked.

Family instances export

The Export Several Documents with Conversion command is now available in the context menu of a family
document. It allows you to export one or more instances of one or more Family documents in any standard
exchange format (Step, DXF/DWG, etc.).

STEP export

Properties of text type (text parameter, user property, enumeration parameter and material parameter) are now
exported.

From a bill of materials, the Import / Export > Export Several Documents with Conversion command now exports
each part in Step format.

IFC export

An extruded bar that does not provide an FEA function will be processed like an extruded element, provided that
the Create explicit geometry for extruded bars option is checked.

4] Opticns O *

ﬁ Shape PSets

9 Sheet Metal
# Sketch 8 Exclude "PSet” string from user PSet name

= Translators
ket Ardis export Exclude properties containing character:

= Blum

HE CutRite export

g OptiCoupe export

.g-l Export cutting conditions optien

+ ol Autocad
g-l Distv nExport drilling cperations
] E57
0_‘} General
.g-l Gtc

5 8B Ifc

.g-l Impeort

PP Sy e | [ P g S P S P ST E S S A S T AP S YV SNy P g

B Create explicit geometry for extruded bars

+ [ F F

8 Create mesh when a modifying operation fails

e
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The new Ignore IfcElementAssembly which contains only one element allows assemblies containing only one part

to be imported as a part.
il Options O *

& Shape IfcGrid Entity
9 Sheet Metal

# Sketch
= 0_0 Translators Font: lsonomD 30mm

Texts

i Ardis export
= Blum Color: <unspecified» x
HE CutRite export olor:
g OptiCoupe export
& Export cutting conditions optien Lines
oi Autocad -
| Dstw Line Style: <unspecified> x
& E57
0_‘} General
@ Gtc
=€ Ife
@ Export
,'.é—l @ Create local parts
@ Preset
@ ME1D Position preducts locally
@ OpenPackage
[ nare fcElementfssembly which contains only one element
[ Pdf 3d ng IfcEl i bly which i by |
] Revit
nmeton il Elacth Ll aa o a e man PR D P S U Y i P (P O S

b 4

Color: <unspecified>

PDF3D export

Layers are now supported when exporting a drafting document, so that they can be shown or hidden in the PDF
viewer.

DSTV export

It is now possible to export an extruded bar’s type and subtype as well as the trims on an imported profile.

Importing ASC and e57

Files in ASC and e57 formats can now be imported as point clouds. Note that a single .e57 file can contain several
point clouds. Importing with conversion imports all point clouds, whereas the Construction > Point Cloud
command imports only the first point cloud.

FBX export

All properties (color, roughness, metalness, etc.) of a PBR material are now exported.

TopSolid
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gITF export

Camera export, texture export mode selection and vertical direction are now available from the command dialog
box.

|nExport cameras

[ Export visualizations

Textures:

None

MNone
Embedded
[ Linked files
-

Advanced Options

[ Compressed

|B+vup

TopSolid'Virtual

When the TopSolid'Virtual application is installed, and if it has been declared in the Tools > Options > Translators
> TopSolid'Virtual section, the new File > Translators > Export to TopSolid'Virtual command transfers the topology
and textures of parts (or assemblies) to TopSolid'Virtual and launches the application.

Translator

Column

It is now possible to add the Document type column to the translation table.
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What's New in TopSolid'Cam 7.18

This chapter describes the new features of the CAM applications in version 7.18 of TopSolid 7.

Hole machining

Drilling: New tools for checking collision points

Checking collision points now supports the following six types of drilling tools:

e Twist drill

* Flat drill

¢ Gun drill

* Spotting drill

e Center drill

e Countersink drill

When a collision points check is performed on a multi-function tool, a warning message is displayed in the Events
window to indicate that only the current tool function is being checked.

Drilling: Collision management with environment

The environment management operation is now independent of the drilling retraction management operation.

The old Always rise up and Check collisions options have been replaced by the Retraction type choice list which
offers the following four retraction types: Without, Always, If necessary and Optimized.

= Work and clearance planes
Retraction type iy Without

Starting altitude IR Without
Value

Always |
+ Shift m -

m If necessary
Between holes
@Autnmatic %‘ﬂ Optimized

Drilling: New intersection detection mode

A new intersection detection mode is available under CAM Options > Drillings > Intersections in the general
options of TopSolid, as well as in the machining document options.

The Operations mode, which was the default in previous versions, only takes into account previous drilling
operations in the document and computes their intersection(s) with the current drilling operation.

In the new Stock mode, the stock is probed to detect an approximation of intersections from ongoing drilling with
material free pockets.
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i1 Options
il General
@ Thémes
B Display
= Printing
™ Analysis
B Rendering
Annoctations
& Assembly
&1 Buildings
5 [lg CAM Options
&% Analyzes
@ Attributes
:;‘- Cutting Conditions
v S
. Fraisa

«-1 G-Code Simulation
el Machined part security shapes

Q’u‘, Tools

ﬁ?} User parameters

(s} Dialeg configurations
-% Display Options

[& End Milling

}'1.- Link movements

{ Machines

[#2 Method

L,- MC Qperations Manager

& Origins

= Optimization

B Limit Optimization
Max. number of holes
500

5% Search options

Options Ll |Start Page | [# Part 1

?

[ Same diameter

[ Same depth

[ Same WCS

[ Same altitude

[ Respect threugh hale

[ Same machining attribute
[ Same color

[] Same positicning diameter

™
. General
. Dimensicning
.. Annotation
| Tolerances
. Sketch
.| Assembly
.. Shape
= L CaMm
@ Machining Tolerances
¥ Analyzes

@ Display
O Hole topo. labels

= Intersections

@ Link Movements

% |so Code Context

@ Turn Link Movements
¥ G-Codeview

@ Turning

Methed to detect intersections

Stock ~
Angular tolerance for stock detection
10°

[& End milling

¥ Driven points

i

7 Workshop Documents

Drilling: Repositioning distance for drillings with pecking

v X ?
(Driling |

Intersections

Method to detect intersection
Stock -

Angular tolerance for stock de

10°

When drilling with pecking, once the tool is out of the hole, it goes back down at rapid feed rate at a certain distance

above the position where it stopped in the previous step. Until now, this was safety distance.

It is now possible to enter a repositioning distance in the Pecking and Chip Breaking/Pecking modes.

52

Hole Machining (Drilling) : Settings

Hole Geometry Altitudes Fine Machining

[= Chip Breaking

|||:| Contouring

] Pocketing

||:| Drilling intersections

"L

Chip Breaki... | Pecking

Drilling parameters
First depth pass
=2mm
Pecking delay
Os

| N

Chip Breaki... Custom pec...

>¥

Repesitioning distance

Tmm

~ | qp

Other depth pass values

=Zmm

TopSolid



What's New in TopSolid'Cam 7.18

Precise drilling: Exit feed rate for blind holes

For precise machining, you can apply the exit feed rate change for blind holes at the end of drilling.

|  Hole Machining (Drilling) : Settings

Hole Geometry Altitudes Fine Machining

||:| Chip Breaking ” ] Contouring
] Pocketing ||:| Drilling intersections

[C) Mono directional positioning
B - Fine machining

>

Fine machining feed rate type 'L Feedrate
Entry distance
Smrm

= -
Feed rate F_& Custom
200mmymin
Exit distance
Smm

-+ -
Feed rate F_& Custom
200mm/min

|8 Blind holes included |

Cylinder and drilling analysis: Sorting drillings per feature

In the analysis of cylinders and drillings, the new Per feature option allows you to sort drillings according to the
diameters and depths of the different features of these drillings.

Group according to

1) Diameter (Per feature)
2) Depth (Per feature)
3) Pesitioning diameter

@ Sorted Drillings

B = @: 18mm-16mm-16mm-10mm
= . d= 1mm+4mm+25mm
w .
g 8: 19mm 19mm 1'.-"mm Bmm-10mm-8mm
E| . d=19mm+1mm+9mm+1mm
g {![[2Holes) p=Omm__] —
@ R Hole 1!
@ R Hole
= s d= 4mm+1mm+24mm+1mm
B8 G2 Holes) p=0mm ] —
@ % Hole1:Non
@R Hole
M3 20mm-19mm-19mm-8mm

sl N Zn s 5P ‘!/ ALCTHE |

WEWWW A1

TopSolid 53




What's New in TopSolid'Cam 7.18

Cylinder and drilling analysis: Hole analysis in 4X axial and 4X radial modes

The new Multi-axis type sort mode allows axial/radial holes to be grouped together to offer a unique WCS for each
group.

@ Sorted Drillings

& Multi-axis type : Mone
%8 Multi-axis type : Four axis axial
%lMuIﬁ—axfs type : Four axis radial |

Group according to

1) Multi axis type
2) Diameter
3) Depth

&y

DSBS B
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2D milling

2D milling: Feed rates in angle management

In angle management for side milling, chamfer milling, edge breaking and Tslot milling operations, it is now possible

to select the feed rate for broken edge segments.

=
H Machining
=.. -

F _#& Custom
=»

Fo% Factor

2D milling: Using plunge and retract of the operation

In the Customized lead in/lead out document, the new Use plunge of the operation and
Use retract of the operation options allow you to use, when necessary, plunge and retract as defined in the
operation, following those defined in the lead in/out document.

Items (5)
4} A |
x | 1. 5egment Cast 5
2. Arc 1
X v | 3.5egment B
t | 4. Segment
| 5. 5egment
4
Preview %2
Lead type Out w
Tool diameter 2rnm 1

Plunge and retract E

[[] Use plunge of the operati... [ Use retract of the operati...

TopSolid
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2D milling: New zigzag milling directions

Four new zigzag milling directions are available for side milling, chamfer milling and Tslot milling operations.

H Technology

Milling directicn

=

_* Zigzag climb last

Compensation method E, Climb
Cempensation diameter M

,3 Conventional
=10,05mm
@ Use compensation code “ ¢ Zigzag climb first

B Without extra fillet -

. Zigzag conventional first
Corner rounding angle e

80° —+  Zigzag climb last

Z path stock fitting strategy .
: Zigzag conventional last

Reposition clearance

2D milling: Forcing the last axial depth

You can force a last spring pass even if there is no path.

2D milling: Management of plunge and retract in chamfer milling operations

Similarly to side milling, the Plunge and Retract tabs are now available in chamfer milling and radius milling
operations to manage the plunge, in and out of material, and retract.

I, Chamfer Milling : Settings

’ Settings < Lead in and cut ﬁ Altitudes

Y Plunge |t Retract | Angle management

2D milling: Chamfer milling in Z axis and on slope

A chamfer milling operation can now be performed either along the chamfer slope, or in the Z axis, like a classic
contouring operation.

2D milling: Preview in automatic search for breaking edges

In the Geometry section of the breaking edges operation, a new icon allows you show or hide the preview of
generated edge sequences.

“#= Topology & #= Topology £
Geometry Geometry
@ @
X § X 4
y %, N 4,
K @!@ ‘\hw/ * 4 1!@
L, L
v @ 1@
= =
- » " -
~
¥ ¥
= Optimization = Optimization

Show Preview * Hide Preview
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Multi-geometry: Reset global operation values

The new Reset parameters icon is available in the Geometry section and resets the values of a geometry, i.e. the
global values of the operation.

Geometry (2)

# Shape 1 <456> Face(804) ge
L] Shape 1 <456 Face(3264)

AGO Q!

\'r Res

£

et parameters |

Side milling: New tool types supported

The disc mill, the radiused staggered teeth mill and the T slot mill are now supported in the side milling operation.

! Side Milling : Tool choice

% List tool

L8 9 UL ol o

Side Mill Slot Mill T Slot Mill | Radiused M... Conic Nese... Chamfer Mill Disc Mill

Radiused 3T | Expand tool...

Side milling: Flat spiral contouring

In the side milling operation, the new Spiral mode on circles and Contouring at the end options are available in
the Radial passes section of the Settings tab. They enable flat spiral contouring based on circle geometry, with the
option of final contouring at the end of the spiral, while respecting normal contouring operation.

& Radial passes %
Maximal radial depth Mumber of radial passes
=10mm 1

Final radial depth pass

=Tmm

I[:] Spiral mode on circles Contouring at the end I
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TSlot milling: New helical mode

As with the side milling operation, the Helical mode option and its associated parameters have been added to the
Settings tab of the TSlot milling operation.

_8 Use helical mode

>¥

Helicoid type == Step
=~

Contouring at the beginni Contouring at the end

Broaching: Retract management
Three types of retracts are now available in the broaching operation: Incremental, None and Value.

You can also enter a retract distance and select the retract feed rate.

= Retracts

>

Retract type
Incrermental ~
Retract distance
1rmm
=+ - .
Retract feed rate F © Rapid
= Rapid
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3D milling

3D milling: Rapid link feed rate

In finishing, superfinishing and material left operations, the new Rapid motions management section allows you
to adjust the rapid link feed rate. Rapid movements (GO) are transformed into feed rate movements (G1) once the
toolpath is calculated.

F ” Rapid motions management

*»

+ -
Rapid feed rate F & Custom

1200mmy/min

Roughing: Computing modes for the conical part on current stock

In the 3D roughing operation settings, the old Take into account the conical parts with in process stock checkbox
now offers three computing modes.

@ ' Tool holder management

>¥

1 B3mm

Lateral safe distance
Omm

: T0mm

Z =afe distance

Ormm

ITake into account the conical parts with in process I g Discretize
¥

Discretization Step for conical parts f Cylinder bottom diam
2mm T
[[J %2 Machine head management J Cylinder top diam

<

-
J Discretize

Roughing: Discretization of conical parts when using tool shape

The Discretization step for conical parts option can also be set in the Tool definition tab of the 3D roughing
operation.

Take inte account the conical parts with in process 1—3‘ Discretize

Discretization Step for conical parts

|2mm

Roughing: Modification of feed rate on approach/retract movements

The new Approach feed rate and Up feed rate parameters allow you to modify the feed rate on approach and
retract movements.
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Roughing: Management of high speed milling tools with two tangent radii

For classic roughing, you can now use a high speed mill with a two radii profile.

- & =

Finishing: Machining only the selected faces on the part

In the Constant Z, Raster passes and Constant step-over finishing operations, you can select faces to be machined
in the Geometry section and, if required, apply a clearance to extend the machining operation beyond the selected
faces.

= Faces to machine management
Faces to machine

Fad Shape 1 <454> Face(12244)
#= Shape 1 <454> Face(36169)
#= Shape 1 <454> Face(36167)
#= Shape 1 <454> Face(12956)
#= Shape 1 <454> Face(36171)
#= Shape 1 <454> Face(11914)
#= Shape 1 <454> Face(36216)
#= Shape 1 <454> Face(36218)
#= Shape 1 <454> Face(36220)

External clearance distance

0,Tmm
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Finishing: Management of stop surfaces

Stop surfaces can be selected in the Geometry section of Constant Z, Raster passes and Constant step-over
finishing operations.

= Stop faces management

Stop surfaces

%, Offsets (XV: Omm ; Z: Omm) [2]

Constant step-over finishing: Contact mode on curves with a radiused mill

The Contact bounding mode is now supported in the bounding curves management of a Constant step-over
finishing operation with a radiused mill. The machining area is the same as for a corresponding raster passes or
constant Z finishing operation.

Superfinishing: Minimum diameter to avoid planar faces

In a superfinishing operation, the new Minimum diameter parameter is available when the Avoid planar faces
option is checked. If the contour of the planar face fits within a circle of minimal diameter, it will not be avoided.

B - Avoid planar faces %
Minimum diameter

10mm

Superfinishing: Improved overlap and Z limitation

Previously, in a superfinishing operation with a 3D curve offset value greater than 0 and minimum Z-path limitation,
there were sometimes unwanted bits of path coming from the horizontal part of the path, going up onto the
vertical walls of the part.

The algorithm has been improved so that these paths no longer appear.

717 7.18

54 54

&
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Residual machining: Minimum material left

In the residual machining operation, the new Minimum material left parameter controls the precision of the
residual material zones, ensuring to not remachine too small zones.

2 Computing conditions

>¥

Step over / Scallop height

0,446318mm <> 0,02Zmm
3D curve offset Max. dist. between points
Omm Tmm

Minimal material left

0,02mm

3D contouring: Collision management

The Collisions tab has been added to the 3D contouring operation settings. It allows you to avoid collisions between
the tool holder and the machine head.

3D sketch: Computing sketches in deferred mode

When creating or editing a 3D sketch, the new Launch Deferred mode means that the sketch is not computed
immediately after the operation has been validated.

In addition, the new Execute deferred operations command on the Additional tab allows you to select and then
execute sketches pending calculation.

b 40 <[
Start Page | [ Test*

t?[i' ilxi_{ LIE & Execute deferred operations... |

Basify

——y

| @ Execute deferred operations

Deferred operations

S L h deferred [] Sketch residual 30 1 (Sketch 1)
t.'_[E aunc e [] Sketch Planar faces curves 1 [Sketch 2)

£
&

3D path trimming: Profile multiple selection

When trimming a 3D path, you can select multiple profiles and choose which side to delete from each profile.

@ Trimming path by profiles

Profiles
Profiles Mode o
Sketch 4
Sketch 3:Profile(17) =
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4D milling

4D milling: New advanced 4-axis radial operation

The new 4X Radial Roughing Advanced command enables roughing based on a rotating axis.

4D milling: Machining on a cone

It is now possible to perform pocket machining on a cone in 4-axis radial mode for end milling and side milling
operations.

I= End Milling : Multi Axis g Start Page | [# Machining 1" |

Multi axis type Q Four axis radial
|w@, Multi Axis Settings ||w@, Strokes
w@, Clearance Shapes | Axis Parameters
2 Active A
Axis
C1(52) ~|
Minimum angle (-5400%) Maximum angle (54007)

Retaticn unrolling

7 Fixed i |:|' iy -
il Iy

Axiz

B

Fixed angle
45°

4-axis axial sweeping: TransMiT mode

You can activate the TransMiT (transformation from milling to turning) mode in a sweeping operation in 4-axis axial
mode.

| Sweeping (Sweeping) : Multi Axis

Multi axis type .@' Four axis axial

|w@, Multi Axis Settings || Axis Parameters |
[5, Four Axis Settings

>¥

Iﬂ Transformaticn from milling to turningl
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5D milling

Auto 5-axis machining

The new Auto 5-axis machining operation facilitates automatic machining of faces with ball nose mill, radiused mill
and barrel mill (taper-spherical, oval, etc.) tools .

Simulation options 2
e teis

Simulation display options 2
Sl

Program A

Tool: ArCutX @16 r4 r1000 r5 a10° z8 - BT40 ER20X120
'WCS: WCS solution 1 [Ongin 1]A:0":C:07]
‘Operation: Face

Program: Programme1

Current driven point position:

X -12.216mm
Y -52.885mm
z -27.607mm
Feedrate:
1848 .247mm/min Machining
Machine axes positions 2
X 353.381mm
Y 3.964mm
z -278.204mm
A 5.012°
C 365,264"
s .

Improved management of undefined normal vector

The Manage undefined vector position option has been added to the Settings tab of the multi-axis settings of the
Swarf and 5D Contouring commands.

The new Choose rotation axis allows you to choose whether solving is executed on only one or on two rotation
axes.

It is also possible to specify how to define an undefined normal vector.

\ Swarf (Face and Background) : Multi Axis »

Multi axis type 'E": Five axis

|w@, Multi Axis Settings ||w@, Strokes ||w@, Clearance Shapes
Axis Parameters |w@, Approach and Retract

“ Tilting management

>¥

Lead/ lag angle Side angle
0® o*
[C] Tilting using main direction

B Manage undefined vector position
Vector to be taken into account

|)l Absolute 7 Axis V| |

Minimum angle

0,5°
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Security area retraction in case of strong angular variations

The Necessary retracts was renamed Retracts management in settings. It allows you to proceed to retraction
in the security area as soon as a large angular variation between two consecutive positions (point + normal) is
detected.

* Retracts management

*»

Automatic starting point
Machine bounds reached

Action on machine strokes If.}@ Begin/End strokes

Large angular variation

»

Change of normal autherized
Max variaticn angle

o0®

Distance side cut to safe

2mm

Asynchronous execution for operations using ModuleWorks

The ModuleWorks commands available in TopSolid'Cam and listed below can be executed in asynchronous mode
(available in the command properties):

* Roughing 3+2

* Multi-axis pocketing

* 4X radial roughing advanced
* Multi-blade machining

* 5X deburring

* Port machining
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Turning

Turning: Geometry start and end points on the fly

In the turning Finishing and Threading commands, you can create a point on the fly via the * icon to define the

start and end points of a geometry.

Roughing: Limit angle display on tool

When a machining limit is defined in X or Z, the angle of inclination of the limit is displayed on the tool. A new icon is

available in the graphics area display bar to show or hide the limit angle preview.

Limits
Limits definition method B Inx
Z limitation
@Value T
+ Shift
= 0mm
X limitation
&l;h'alue Omm
+ Shift
= 0mm
Limit angle
20°

Groove roughing: Plunge overlength

In the groove roughing operation, the new Plunge overlength parameter is only available for the
Square mono-directional, Square bi-directional and Alternate roughing types.

»* Roughing (Groove Roughing) : Settings

Main Strategy Leveling

2

Stock to leave / limits |

Altitudes

Axial pass depth
3mm

Feed rate value l? Machining
= Q.2mm/rev

Safety distance

2mm

Safety distance on flanks

Omm

Plunge overlength

0,3mm

66

Groove roughing method E Square mono-directional
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Boost roughing: Undercut management

The turn roughing operation in Boost mode now manages undercuts. To do this, check the new Undercut option,
then enter the draft distance accepted by the tool.

= Roughing (Boost) : Settings

Main Stock to leave / limits Altitudes

[C] Opposite side axis work

External clearance

= Machining type

® = undercut

» o

Undercut distance
0,65mm

Boost roughing: Loop HSM feed rate and link HSM feed rate

The new Loop HSM feed rate and Link HSM feed rate parameters are used to define loop HSM feed rate and link
HSM feed rate.

= Link management A
-+

Loop HSM feed rate F__ Machining
= 0.3mm/rev
-+

Link H5M Feedrate F ~ Maximum

= 1570.796mm/rev
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Virtual jog and link movements

Virtual jog: Spindle rotation management

The Spindle action function has been added to the virtual jog. It allows you to select the rotating element and the
spindle rotation direction.

The Automatic mode manages the rotation of the spindle selected in the current operation.

Spindle action... b 4§l Start Page
= = = —
Spindle action... X Rotating element: &' Automatic

Ll

Rotating element: g, Automatic &
= Spindle rotation direction: # Automatic
Spindle rotation direction: 0{ Tool 4
L Clockwise (M3)
Yoo
- =
’b’f Part 3
u Counter Clockwise (M4)
<]
wt Tool and part "é‘ Automatic
<]
wf Automatic ”
4 None

Virtual jog: Coolant management

The Coolant activation function has been added to the virtual jog. If a coolant document is selected in the machine,
it is taken into account.

The Automatic mode manages the coolant selected in the current operation, while the Manual mode selects all
coolants in the coolant document.

Coolant activation...
Coclant method I.E Automatic
Cooclant activation "-fn‘.-" Active

Virtual jog: Additional steps to approach the part
Additional steps can be added to the Approach to hold part function.

Second step to approach the part
Stock

+ Shift

=
Feedrate: F_ Machining

-

Added step to hold part
k.
Stock

+ Shift

=
Feedrate: F__ Machining
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Link movements: Spindle rotation management

Similarly to the virtual jog, the new Spindle action function manages/triggers spindle rotation in approach and
retract movements.

- Link from change tocl position - 1: Roughing 3+2 (5¥) O

)
fai's

=1

Method qu Manual

Starting Position (1 : Roughing 3+ Rotating element: ‘J; Automatic
Spindle acticn o
Movement to coordinates Spindle rotation direction: 7 # Automatic

Movement to coordinates

4
x Movement to coordinates
JL End Pesition (1 Roughing 3+2 (!

Link movements: Coolant management

Similarly to the virtual jog, the new Coolant activation function manages/triggers coolants in approach and retract
movements.

“, Link from change tool position - 1: Roughing 3+2 (5X) O X

=] i

-

Method qu Manual
Starting Position (1 : Roughing 3-  Cooclant methed ¢ Automatic
r
Coolant activation A
MWovement to coordinates Ceelant activation (0N Active

Movement to coordinates
End Pesition (1 : Roughing 3+2 (!

!
X
x Movement to coordinates
4
Link movements: Security distance specific to internal turn roughing

The new Security distance turning link movements parameter allows you to modify the security distance for the
link movement only. It is available on the ISO tab of the operation’s comments.

*'.-f-,. Solutions

Show normalized rotations

Cur.. Type Pot Afl. B .. f}
@] & (T 0" 0° y
@] & (T 180°  |0°
QO | & [T 180°  |80°

= Link movements

»

Security distance turning link movements

2mm
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Link movements: Subfolders creation
Subfolders can be created and managed when saving or editing link movements.

=

Link movements: Optimized changeover from manual mode to automatic mode

Modifications made when editing a link movement in manual mode are kept after switching to automatic mode and
back to manual mode, as long as the editing window remains open.

The new Reset items option resets the elements in manual mode.

Starting Position (1 : 5 axis deburring (5X]))

Security Cylinder

Mowvement to coordinates

Security Plane

Mowvement to coordinates

Mowvement to coordinates

Mowvement to coordinates

End Position (2 : 5 axis deburring (5X))

" N
D ¥ ¥

Rezet iterns
e
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Tools and cutting conditions

Tools: Importing GTC tools

Tools exported in 13399 (GTC) format can be imported, either by dragging and dropping the ZIP file, or by using
the Import File with Conversion command and selecting the GTC Package (*.zip) file type. If the ZIP file is usable,
the dialog box below appears.

MILFI_Fr_Face Mill D40.zip O ®
| Assembly ” Adaptive item || Adaptive item || Tool ltem
Vendor: CoroPlus ToolLibrary
Product Id: [Fr_Face Mill D40 |
Generic class Id: ||'\.1||_F| |
Vendor class Id: ||'\.1||_F| |
Model: |None - |

v X ?

Tools: Adding a joint from the assembly wizard

When using the assembly wizard, a new option allows you to add a joint with the ground, in order to correctly
compute the minimum output length of the tool when assembled with a machine component.

» ¥ ?

P8530301
=] Add Component ...
Tocling Systemn Frame < 162> (Cylindrical Tecling Sk

Frame Socurce -

B Add joint with the ground I
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Tools: User driven point and tool output distance

You can modify the tool output distance after creating a user driven point. The driven point position will remain
consistent.

Tools: PP words and notes in workshop documents
PP words and notes added in tools can now be retrieved in workshop documents thanks to two new variables:

* ToolPPComment for PP words;
* ToolWordPPNotes for notes.

Tool manager: Sorting tool types
The tool manager now displays a first line listing the tool families, and a second line corresponding to the tool types
in the selected family(ies).

I g
| %ss Tool Manager

= List tool

ARl 1Y 2

] h s
(Y & S | S, eap
Drills Mills Reamers Taps Turnings Probes Blades Grinders All Types
f n I F n
i r s | ¥
& E i £l
Constant R...  Boring Bar Tap Ext. Thread ... Int. Thread ...

Magazine: New variables of tool functions

New variables of tool functions are available:

* Cutting edge size

* Cutting edge width
* Cutting edge depth
* Thread pitch

« L (Cutting length)

r (Corner radius)

<

« | Cutting edge size
Cutting edge width
Cutting edge depth
Thread pitch

«  Description

Magazine: Tool selection via mouse wheel

You can either select a tool by checking the corresponding box or use the mouse wheel (central button) to click on
the line of the tool you wish to select.
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Magazine: Magazine, tool holder and pocket choice lists

The choice lists for magazine, tooling holder and pocket have been grouped together under the tools list. To
improve the information visibility, the display is adjusted to the window size.

% Roughing (Roughing) : Tool choice

= List tool
= B B BEE B B
P & P P T »

C-Rhombic ... D-Rhembic... P-Pentagon... R-Circular 1... 5-Square 90 T-Triangula... V-Rhombic ... W-

Element Magasin Broches  ~~ Teool holder Téte detournage  ~ Pocket T22 ~

Magazine and cutting conditions: Number of teeth display

A column can be added to display the number of teeth for each tool in the tool magazine, as well as in the cutting
conditions table.

Cutting conditions: Validation of an operation forbidden in invalidity cases

It is no longer possible to validate an operation if one of the cutting conditions is null or invalid. This also applies to
all rotation and feed rate speeds in the settings.
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Verification and simulation

Verification: Browsing cuts

The new Browse command allows you to check machining operations one by one, and to visualize any movements
with collisions. This command can be found in the Verify tab, as well as in the context menu, and is only active in
the verification context in programming simulation mode.

v

= Operati

b | Clree seE]l % @

ons

r
S

6: Facing
T: Facing

5: Open pocketing

8: Open pocketing

9: Open pocketing
10: Side Milling
11: Side Milling

]

. 4

Z= Tool path

L W

60

G
961

[ B

& 962 -
& 963 -
B @ 964 -

& 9m2-

- Lingar cut
- Linear cut
Linear cut
Linear cut
Linear cut

- Linear cut

- Linear cut
- Lingar cut
- Lingar cut
- Linear cut

470 - Linear cut

- Linear cut
Linear cut

Cut interpol

lation

Verification: Display for remaining material

The Display undercuts/overcuts command has been added to the Verify menu and to the context menu.

It can only be accessed at the end of verification of the selected machining range, with the animation mode
(programming or machine) and with the material removal activated.

Similarly, at least one stock/finish pair must be present in the verification. Parts without finish and/or no stock are

not accepted.

> | B[ = &

Q??/

Primitives List
g Parts
5%

Stock Machined Part 2

AgiE | SR | @

74

[J Undercuts
) Overcuts

EHements to display

[ Hide the stock
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Verification: Simulating rotating elements

In the Display tab of the Settings command, three new representation modes allow you to adjust the display of
rotating elements when checking a turning operation:

 Standard: Displays rotating elements in 3D mode (non-rotating).

* Spun: Shows elements in rotation mode (silhouette of element rotated).

 Standard and spun: Shows rotating elements in 3D mode (opaque display) and elements in rotation mode
(transparent display).

* Misc.
[ Display textured tools
@ Display gradient background
8 Display compass

Stock section

Full 1/4 1/2 3/4 1/3 2/3

I:I Invert the view section plane

Representation

* Q@

Standard Spun Standard a...

Verification: Cross section view on selected elements

If you have created a graphics cut in the CAD or CAM context, indicating the elements to be taken into account, you
can activate it during the verification phase, only on the elements previously selected.

Verification: Inversion of the view section plane

The view section plane can now be inverted in the Display tab of the verification settings.
> Misc.
[ Display textured tools
@ Display gradient background
8 Display compass

Stock section

Full 1/4 1/2 3/4 1/3 2/3

II:I Invert the view section plane I

Representation

* Q@

Standard Spun Standard a...
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Verification: Toolpath tolerance adjustment in machine mode

A new parameter in the Animation tab of the verification settings allows you to adjust the
4/5X cuts interpolation tolerance, with the aim of improving performance.

[ I_"| Settings
|ﬂ General ||4;,: Incidents ||€ Comparison ”E Rapid mode ||‘ Animation ”b Display

# Simulation options

Split toolpath by

s o

Element Length

Machine mode: 4/5% cuts interpolation tolerance

0,0001mm

Verification: Activation/Deactivation of comparison colors

In the Comparison tab of the verification settings, it is now possible to click on a color in the legend to activate or
deactivate it globally.

You can also hide a color directly in the comparison context by clicking on the legend; the display is automatically
updated.

Verification: Using directional and scroll keys

Using directional arrows and the "Page Up" (previous page) and "Page Down" (next page) keys is now possible while
checking to orientate the view.

Verification and simulation: Displaying X as a diameter in turning operations

In simulation and verification, the new Show X as diameter in turning operations option displays the X axis
coordinate of turning operations as a diameter. It can be accessed via the context menu in the simulation or
verification window, and is activated by default.

Show/Hide
Decimal Digits
Font Size

Positions Display

«  Show X as diameter in turning operations i

Verification and simulation: Pause in case of out-of-stroke axis
During simulation or verification, it is now possible to stop at the point where an axis limit is exceeded.

For simulation, check the new Pause simulation at exceeding machine strokes option available from Tools >
Options > Machining > Simulation.

For verification, select the new Axis limits exceeding bounding mode available from the Stop at section in the
General tab of the verification settings.
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Center window

What's New in TopSolid'Cam 7.18

When creating and/or editing a general milling/turning method or a wire method, the method is now displayed in
the central window, rather than in a pop-up window.

Part analysis

The new Analyze Part analysis function retrieves the minimum and maximum coordinates of an NC part and its
stock, as well as the part's color and material.

WCS are not mandatory, but are essential to get the values for the part or stock dimensions. Coordinates are given

in relation to the WCS.

Part¥Min : Result of Analyse Part 1 XMin
Part¥YMin : Result of Analyse Part 1 YMin
PartZMin : Result of Analyse Part 1 ZMin
Part¥Max : Result of Analyse Part 1 XMax
Part¥YMax : Result of Analyse Part 1 YMax
PartZMax : Result of Analyse Part 1 ZMax

PartStockXMin
PartStockYMin
PartStockZMin
PartStockXMax
PartStockYMax
PartStockZMax

: Result of Analyse Part 1 StockXMin
: Result of Analyse Part 1 StockYMin
: Result of Analyse Part 1 StockZMin
: Result of Analyse Part 1 StockXMax
: Result of Analyse Part 1 StockYMax
: Result of Analyse Part 1 StockZMax

PartColor : Result of Analyse Part 1 Color
PartRed : Result of Analyse Part 1 Red

PartGreen : Result of Analyse Part 1 Green

PartBlue : Result of Analyse Part 1 Blue

PartPartMaterialDescription : Result of Analyse Part 1 PartMaterialDescription

Face area and profile length

The Analyze Face function now retrieves the area of a face and the Analyze Profile function retrieves the length of

a profile.

Find a document

The new Find Document search function allows you to find a document from its name in a specific folder, project or
library, and use it like a document variable in methods. If no folder is selected, the method will search in the current

project and its references.

The documents eligible for search are the following:

e Customized lead in/lead out

* Customized drilling
* Link movement

TopSolid
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o L =5 2 Main
X4 ¥=EEE | |
Active Al B P
= Milling/Turning Method S
&Y Find Document 1 Folders
Document Type Custom Pecking b
Document name |U5er Pecking 1 | >
ResultPrefix | |

Edge profile in element selection

When executing a general method, you can create a profile on edges directly from the selection of profile-type

elements.
@ Picking elements

Choose a profile
171 <ok
Selection
Boundary Edges Profile...

e
o

Edges Profile...

Search with special characters

You can search for an element/entity or machine component from part of its name or description by adding a
special character. The special character * replaces a character or a string of characters and the character ? replaces
a character.

This search mode is compatible with the following actions:

* Find Elements

* Find Machining Feature (MF)

¢ Find Document

¢ Find Machine Axis

* Find Machine Element

¢ Find Machine WorkStation

* Find WCS from a given geometry
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Material side reversal in 5D contouring operations

Similar to 2D operations, you can now select the material side of the curve to follow in a 5D contouring operation.
Three choices are possible:

* Given by profiles: The direction of the profile gives the material side.

» Reversed All profiles are reversed.

* Result of profile to machine analysis: Each profile can be reversed or not (the result is provided by the
Analyze Profile function created before the machining operation).

Resizing of the dialog box and zooming in on images

When executing a method, you can resize the dialog box and zoom in/out on images.

Information image for dialog box

When defining the information image for a dialog box in a general method, the new Edit drivers areas button
allows you to frame a particular area of the image in red, to make it easier to understand the question when
executing the method.

Start Page | ¥z Method® ¥ X
\ = | Main
FXAVLEE [
ctive Al a3
= Method S ~ =]
= j Dislog Box 1 Information image Edit drivers areas.

g=| Information Image 1

:1_ Input Real 2 (Radial Step Over:)

:1 Input Real 3 (Stock to leave on wall 1 ) ,}2\3

—
Method View Command O X
Drivers: Select a driver, then draw the rectange which defines its associat...
Input Real 2
Input Real 3 ".
.
.
., N
y
A3
.
.
«Q.
t,
b
A
l Delete areas
v X ?

Preselection of the original method

When exchanging a method with another, the original method is now preselected by default if associativity with the
method was required.
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Miscellaneous

Machined part setup document: Hiding selected entities

When defining the machined part setup document, the new Hide option hides the entities already selected in the
Finishes, Stocks and Environment fields.

Finishes, stocks and environment X

Part setup configuration
=% Finishes A

Finish:

| Part1 <152> |

[ Hide

Derived machined part setup document: Derived NC part editing

The new Edit derived Part NC command is available in a derived machined part setup document. It allows you to
add environment elements, as well as auxiliary elements (additional surfaces, check surfaces and bounding curves).

Finishe,stocks and enironment Rsecres ] - -
#% Environment % Q? % Additional surfaces Q? ¢
)
@

@ @

Check surfaces

[ Hide

#% Inherited environment

»

Bounding curves

Fixture <157 >
Fixture <159
Fixture <161
Fixture <163 >
Fixture <165>
Fixture <167 >

Fixture <169>

Fixture <171>

Hide
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Part repositioning: Inheriting environments

The repositioning command features the new Inherit environments option which allows you to inherit or not from
the environment defined in the machined part setup document.

\)}6 ,

@ Part Repositioning

Part
||Machined Part 1 v||

Repositioning in:
(") Same document

© New document

() Existing document

8 Inherit environments

Environment: Creation of environment sets

You can create environment sets to use in environment activation/deactivation. To create a group, right-click on the
Part Environment folder in the Entities tree and select the Create environment set command.

Environment: New environment activation options

The environment activation window displays two new columns of checkboxes:

* The first column is used to show or hide the environment element during simulation/verification.

* The second column is used to take into account or not the environment element in the calculation of
machining toolpaths.

= Part

Part ||Machined Part 2 v||

= Geometry

Limit shown envirenment to :

|N0ne vl

Envircnment elements

% |
Fixture < 590>
Fixture <822>
Fixture <651>
Fixture < 758>

REEE] b
OO0&E

Repetition in the operation: Environment management in rapid movements

The environment can now be managed in the link movements of the operation’s internal repetitions. If the final
altitude defined in the operation is greater than that of the environment, retractions are made to the final altitude.

Patterns: Analysis of the number of elements in a pattern

Using the Analyze command on a pattern allows you to find out the number of elements it contains.
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Patterns: New combined pattern

The new Combined Pattern pattern allows you to make the sum or multiplication of multiple patterns.

Patterns are applied in the same order as they appear in the list.

@ Combined Pattern

MName:

|Pattem 1+2 |

Patterns:

O -

Pattern 2

Patterns: Pattern optimization

The new Pattern Optimization command offers three modes for optimizing the path through the pattern:

* 2-Opt optimization
* Sweeping
* Optimized sweeping

The result displays the number of points, the total path length and the computing time.

You can modify the preview by displaying the points and a gradient of colors from the start (green) to the end (red)
of the path.

X ?

@' Pattern Optimization ...

Pattern:

FP1

Method - — p—

AN
© Shortest path — ___ AV NRVANR VAN \\l\ .
) Sweeping L

() Optimized sweeping

—

| Threshold:
1000

MNumber of points: 658
Path length: 13,.316m

Broints
[ Gradient

@ Advanced Options

Repeated point:

Sketch 3:Vertex(3) ~ | dp

a Madify numbering
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WCS No description for manual WCS

What's New in TopSolid'Cam 7.18

When a WCS (face or frame) is created manually, the WCS Description field is no longer filled in automatically with
the value of the initial WCS solution.

Copy/paste operations: Behavior of technological points

In the Options > CAM Options > NC Operations Manager command, you can choose whether to copy existing
technology points when copying/pasting an NC operation.

il{] Options

B Rendering
Annctations
& Assembly
&1 Buildings
=l [l CAM Options
¥ Analyzes
@ Attributes
:j Cutting Cenditions
oV Drillings
. Fraisa
\1 G-Code Simulation
e Machined part security shapes
9 Tools
3',‘.3 User parameters
(=) Dialog configurations
-'% Display Options
[& End Milling
}'1,- Link movements
4 Machines
[#2 Method
B 11C Opersions anager
e Origins
#% Part settings

O X 1
Copy/Paste : Set new machinings as Defered 7
O Askforit
() MNever
O Always

Copy/Paste : Copy also the techno points if necessary 7
© Askforit
() Mever
() Always

MNC Cperaticns management
8 Display new operation's toolpath
Display

B Show insertion operation

Select the default columns to display

e REY
=5 . v, =)
| | a=F M o %

Werified Clashes | Medificators |User messa..  Belongs to ..

LTI TT]

Copy/paste operations: Creation of machinings in deferred mode

When copying and pasting a machining operation, you can create the operation by activating the Launch deferred
mode, in order to choose when the operation is to be computed.

This feature can be configured in the Options > CAM Options > NC Operations Manager command.

TopSolid

it{| Options O X ‘|
B Rendering Copy/Paste : Set new machinings as Defered 7
Annotations O Askforit
- A5§embly O Never
& Buildings
= l5 CAM Options O Always
% Analyzes Copy/Paste : Copy also the techno points if necessary 7
?‘ Attributes © Ask for it
% Cutting Conditions
oV Drillings O Never
. Fraisa O Always
44 G-Code Simulation MC Operations management
k¢ Machined part security shapes
9 Tools B Display new operation's teolpath
3"1 User parameters Display
(s} Dialog configurations
.ﬁ Display Options 8 Show insertion operation
[E End Milling Select the default columns to display
}'1,- Link mowvements ) = 3 &5
2 Machines 4} E s o
o . B W N
{2 Method = i | | = M o =%
B MNC Operati =
E" p:ratmnsManag:r Werified Clashes | Medificators |User messa.. Belongsto ...
< Origins
o Part settings
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Selection: Selection of elements with cylinder search

The Create selection from similar cylinder selection command has been added to the Visualization tab to make it
easier to select cylinders with the same criteria (diameter, depth, etc.).

1 E=n F P [FRas Al
:| "F.’Eﬁ*’i};ﬁ

¥ =0 ?

Part

||Machined Part 1 v||

Reference face

| ~|*x

5% Search options

Same diameter

Same depth

[ samewWcCs

[ same altitude

[] Respect thraugh hole

[J Same machining attribute
[ same caler

[J Same positioning diameter

Selection: Associativity of selection with machining operations

In all machining operations that accept a selection of elements, the link is now associative by default. If the selection
used is modified (geometries added or deleted), the machining operation must be replayed.

To delete associativity, right-click on the selection and select the command Split all geometries command.
“= Topology %

Geometry (1)

B | &=
Split all geometries i

Scenario: Simplified return to machining stage

Previously, double-clicking in the scenario window gave access to the final machining stage, but not to go back to
the machining stage.

You can now double-click on the desired part origin symbol to return to the corresponding machining stage.
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Scenario: Scenario sequence in the operations manager

It is possible to apply the scenario operations order in the operations manager for multichannel machines without
requiring part repositioning within the same document (no repositioning step in the machining document).

This feature was already available for kinematics with a single part holder and one channel.

The new Simplified scenario mode icon, accessible in the machining final stage, enables the display of operations
in the sequence outlined by the scenario. When this mode is activated, three new icons appear on top of the NC
Operations tree:

o
« [I7: Applies the operations sequence from the scenario in the operations manager.
&

« o= Verifies scenario validity.
~
. é: Updates the scenario.

544 Wes @154 B:0%; C1 (52) : 0°]
-'7 3: Centering/Pointing

S20[34|C1(52): 907
B8 10: Centering/Pointing

CSO[54|B:07;C1(52):07]
B3 25 5: Drilling

WCS 19 [54C1 (52): 0°]
B &5 11: Drilling
4 WCS 20 [54 | C1 (52) : 90°]

EWE= 17 Mrillinn

B iEet o

Y

Control points: New cycle types

In the Control Points command, the Cylinder, Corner, Slot/tongue and Rectangle types integrate the new
Cycle type parameter which proposes the following modes:

* Direct: The tool is positioned directly in XY at the first control point.
* To the center: The tool is positioned in XY in the middle of the cylinder, slot, rectangle or corner.

i Control Points (Cylinder) : Operation Settings X
Parameters ﬁ Altitudes

Cycle type Q‘!_J To the center

Control Points mode C I I To the center

Approach distance

L I J Direct

10mm

Control depth
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Technological points: Definition of an end point for feed rate application

You can define an end point when creating a technological point of Feed rate type.

Edit technological point

Point

||Midd|e:5hape‘l <455=:Edge(3 v| dh |

Position
Segment start v
Type
Feed rate w
r__m
Custom
123mmimin

@ Define end point:
) Medify rapids:

Select a point

V|¢ - -

Select a position

Presets: Filters in the preset selection
You can apply filters when selecting a preset by right-clicking on the desired column name.

Filtering is about the next columns:

* Preset name

* Tool type

* Tool description
* Machine

Graphics area: Displaying coordinates according to a WCS or an origin

Previously, the display of the mouse’s XYZ coordinates in the graphics area (at the bottom of the TopSolid window)
was depending on the absolute frame.

It is now possible to specify another frame to obtain a second display of the mouse's XYZ coordinates.

X=+036,666 Y¥=-031,090 Z=+000,000 £ Visualization: 0,05mm 5°
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Grinding

Part rotation direction

What's New in TopSolid'Cam 7.18

In a grinding operation, the new Part spindle rotation parameter allows you to choose the rotation direction of the

part. The Auto mode matches the behavior found in previous versions.

H Technology
L"‘—F'—J
Axial Strategy = Zigzag step

B Retract at the same point

Tool Spindle Rotation ) M3
IF'art Spindle Rotationl "jﬂ Auto
Positionning Angle 4y m:
. .I:.

= Grinding Settings u M4
Tt Py Auo

=0mm

Wire

*»

*»

Wire: Information transmission between the wire document and the machining

document

When creating a machining document from a wire document, information can be transmitted via drilling MFs to

automatically drill the threading holes.

FEECEEEEER

| = = = m
faa| Gtk SR [ 137

O = %F MF
] 5 Wire MF 2 (DrillingFeaturesBuilder)
] 5 Wire MF 1 (DrillingFeaturesBuilder)

The machining document created from the wire document automatically inherits from the wire document’s MFs,

enabling the associated drilling operations to be performed.

B o [5 w3 ofs o 755 21 %

o =8 S e Q1
| iy B9 P 17

70 Teols
10 Lists
O = %F MF

O & Wire MF 2 {Inherited MF (Wire Machining J)
O & Wire MF 1 {Inherited MF (Wire Machining J)
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Wire: Cutting type in the operations name

The wire operation name displays information on the cutting type (2X or 4X) and the maximum angle.

Fo
=% WCS 1 [Origin 1 | No rotation]
=@ Wire geometry 2 (DG=0mm)
[ Gl 1: Full cutting - [2X) - Wire geometry 2 (DG=0mm)
=@ Wire geometry 1 (DG=0mm)
-t W Gl 2: Full cutting - (4X)(0,2017) - Wire gecmetry 1 (DG=0rmm)
=@ Wire geometry 4 (DG=0mm)
[ Gl 3:Full cutting - (4X)(5%) - Wire gecmetry 4 (DG=0mm)
=@ Wire geometry 3 (DG=0mm)
[ _.? 4: Full cutting - (4X)(18,4347) - Wire geometry 3 (DG=0mm)
=@ Wire geometry 5 (@8) (DG=0mm) , Wire geometry & (DG=0mm) , Wire gecmetry 7 (DG=0mm)
w [ _.? 5: Full cutting - (4X)(4,025%) - Wire gecmetry 5 (28) (DG=0mm)...
=% Machining Stage

Wire geometry: Wire geometry name

When creating a wire geometry, the Name field is now blank by default. If you leave this field blank, the default
name will be applied (behavior from previous versions). If you enter a name, this will define the start point of the
wire geometry, before downsizing and possibly the diameter.

Wire geometry: Diameter in the wire geometry name

If the geometry is a cylinder or a circle, the wire geometry name contains the diameter value.

=1 ([0 Wire geometries
@ Wire geometry 2 (©14) (DG=0mm)
#= Wire geometry 1 (DG=0mm)

Wire geometry: Improved visualization of limited wire geometry

If a limitation is specified in a wire geometry via the Starting point and Ending point fields, its visualization is now
improved in the final preview in the graphics area.

Wire features analysis: Red arrow on wire geometry

When the Echo Arrow in Dialogs display command is activated in the wire document, a red arrow is displayed in the
graphic area, pointing to the geometry selected in the wire features analysis.

Wire technology: Roughness management

You can enter roughness values from a wire technology document.

Roughness
Ra Rz

1.4um
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Wire technology: Management of lead in and lead out technologies

Lead in and Lead out new technology types are available in the wire technology document, as well as in the wire
method.

Each type of technology now features a distinct icon, simplifying identification when searching a technology.

Technology Type

4 Finishing

3¢ Finishing
"= Lead in
2 Lead out

When selecting the main technology in the wire technology document, if only one lead in or lead out technology
exists, it is now automatically selected in the Lead in or Lead out tab.

Similarly, when selecting a technology from a method, if a lead in or lead out technology is required and the
technology document contains only one lead in or lead out technology, it is automatically selected.

Wire technology: Current technology by default
A wire technology is selected when creating the first cutting operation on a geometry.

In the second cutting operation created on the same geometry, the technology selected by default is now the
technology used for the previous operation.

Wire method: Choice of technology according to the part material and thickness

The two new variables PartMaterialDescription and HeightCutMax are available in the wire method. They can be
used in a technology selection action to set the part material and maximum cut height by default.

+ X4 EE ]
uus W15-1 fac_e - Search auto Active Always " .
= Sélection €lément 1 (Select element)
= Questicn |Se|ect techno | £
Wire diameter o
Wire material | | i
Part Material |=ME.PEPartMateriaIDescription | E
Height cut max [=Me PEHeight CutMax | >
Wire cutting number 0 B
Rz Opm >
Ra Opmn >
Wire finishing methed
|
Reughing Finishing Lead in Lead out
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Wire cutting method: Wire geometry creation

The new Create wire geometry function creates wire geometry directly within the method. The same parameters
can be defined as those available when manually creating a wire geometry in a wire document.

Start Page | iz Wire Method 17 ¥ X
dh x y ’ H Main ” Settings |
+7 Wire Method 1 .
w Active
Create wire geometry 1 ke bl | W
Geometry type ~ (@
One profile | Two profiles Faces

First curve Mothing V

Draft angle 0° B

Smoothing tangent elements ) T 1
f [
[ |

| l|

J[ LA

Conic (cons... Cylindric (is...

Smoothing non tangent elements ' rI.I
| [
[ |
(¥ |
L] 3 |

Conic | Straight an..

Geometric compute frame Mothing -

Height to cut Part height

A

Downsizing Omm oy

Result name or prefix ‘ |

Geometry Recall ID ‘ | 5>

Workshop document: Falling part

The new DistanceFallingPartCutting property is available in the Standard > Machining >. Geometry and Standard
> Machining > Operations > Wire > Cutting sections of workshop documents.

This value matches the falling part specified in the second part of the wire geometry definition.

Workshop document: Wire technology document name

In order to retrieve the name of the wire technology document used in the cutting operation, the following three
properties have been added to the Standard > Machining > Operations > Wire section of workshop documents:

* TechnologyDocumentName
* TechnologyDocumentNameLeadIn
* NameDocTechnoLeadOut

Workshop document: Wire material

In order to retrieve the wire material name defined in the wire technology, the following three properties have been
added to the Standard > Machining > Operations > Wire section of workshop documents:

* WireMaterialTechnoDoc (wire material name for main cutting)
* WireMaterialTechnoDocLeadIn (wire material name for lead in cutting)
* WireMaterialTechnoDocLeadOut (wire material name for lead out cutting)
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Simulation: Maximum draft angle

The maximum wire draft angle defined in the wire machine is taken into account when simulating a cutting
operation. The wire angle text is displayed in red if the maximum value is exceeded.

Specific wire informations A

Angle 27.178°

In the operations manager, the operation is underlined and a user message appears, plus an error message when
the operation is executed. Synchronizations outside the limits are shown in red in the graphics area.

Simulation: Wire simulation scale

You can adjust the scale to the wire diameter during simulation, without modifying the actual wire diameter. This
parameter is available in the wire document options, as well as in the simulation window. You can set a scale factor
for each wire document.

Options Rl Start Page | &% Wire 2 | Simulation Ay StortPage | 4 Wire 2*.
o oo [ ? # ¢ ? Simulation options £
B - i A
= Generd e tgis
j Dimensioning :

j Annotation Simulation display options

bed

Lead in points distance

| Tolerances =
[ Sketch 2mm 25 &
[ Assembly Lead out points distance Program ¥
& shape Machine axes positions
= caM Zmm v
%] Machining Tolerances Specific wire informations a
#% Analyzes Search distance for threading ...
) Link Movements Angle 0.000°
% Iso Code Context -
Y G-Code view Falling part Wire simulation scale:
.- Turning Tmm '
[g End milling Lead out distance
¥ Driven points Zmm
oV Drilling Threading diarmeter
7 Workshop Documents 3mm
@ Start/finish add vertical syn...
syl
Full circle
Start angle

o
[ ] Threading point at center

Simulaticn

Wire simulation scale

5

Technological points: Improved display for stops

The visualization of Stop technological points has been improved. The letter M followed by the number is displayed
if the value is between 1 and 5; otherwise, only the letter M is displayed.
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What's New in TopSolid'Tooling 7.18

This chapter describes the new features of the Split, Mold, Electrode, Strip (Strip design) and Progress (Progressive
die) applications in in 7.18 version of TopSolid 7.

TopSolid'Split

Set attributes

From now on, only surface shapes can be added to the Parting Surfaces set and only solid shapes can be added to
the Action Insert Shapes, Insert Shapes and Core Cavity Block Shapes sets.

In the Split Blocks document’s Options tree, the new Split Blocks > Attributes > Sets category allows you to assign
color and/or transparency to parting surfaces when they are included in or removed from the set.

Parting surfaces inclusicn
Color:
Transparency:

' 50% )(

Parting surfaces deleticn
Color
Transparency:

[ | 0% %

You can also predefine attributes for the Action Insert Shapes, Insert Shapes and Core Cavity Block Shapes sets.

The color and transparency of the parting shapes are transferred to the parts generated by the Split Blocks
document and included in the mold.

Publishing entities

The Publishings submenu has been added to the Tools menu, which now allows you to publish entities in a
Split Blocks document. These are then copied to the assembly from the Split Blocks document and to the mold.

Layers

If layers are defined for parting shapes, they are associated to the parts generated by the Split Blocks document.
When the assembly from the Split Blocks document is included in the mold, layers are kept on the part shapes.

Layers must be similar between Split Blocks and Mold documents. It is recommended to predefine the layer sets in
two Split Blocks and Mold template documents.
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TopSolid'Mold

Including core cavity blocks

In the inclusion command, the new Copy publishings option allows you to copy the entities that are published in

the Split Blocks document.

Occurrence name:

Document:
| & Plug v|
Code:

|B Copy publishings |

Heel

Initialization of settings

To facilitate and speed up the creation of similar heels, you can initialize the parameters and settings of the Heel
command, based on those used to create the first heel.

Simply select a face from the first heel before launching the command.
Pin

Initialization of settings

To facilitate and speed up the creation of similar pins, you can now initialize the parameters and settings of the Pin
command, based on those used to create the first pin.

To do this, simply select a face from the first pin before launching the command.

Trimming tolerances

The trimming created by the Pin command is based on a linear tolerance of 0.01mm and an angular tolerance of
0.05°. To modify these values, it was previously necessary to use a context-sensitive command on the trimming
operation performed in the pin document. Trimming modeling tolerances can now be adjusted directly in the
Advanced Options section of the command, thus avoiding in-place editing of the pin.

Trimming linear tclerance:

0,01mm

Trimming angular tolerance:

0,05°

TopSolid 93



What's New in TopSolid'Tooling 7.18

Pin processes
Boring length
The boring length was previously computed from the machined length of the pin.

In version 7.18, this length is computed from the minimum machined length, thus avoiding machining problems in
case of pins with a large amplitude trimming.

Boring length computed from the machined length. Boring length computed from the minimum machined length.

Cooling

Symmetrical pattern repetition

It is now possible to repeat the components automatically included in a cooling using a symmetrical pattern, which
automatically generates a Local mirror operation.

Modify drillings

The Modify Drillings command features the new Reverse direction option, which makes it easy to reverse the
directions of several cooling drillings simultaneously.

@ Parameters

[ Diamneter

10mm

[C] Cwerlap

Bmm

B Reverse direction

Modify baffles lines

The new Modify Baffle Lines command is available when editing a cooling sketch. It allows you to easily modify the
diameter, direction, reference plane and depth calculation mode for a batch of selected baffle lines.
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@ Diarmeter
10mm
@ Modify Baffle Lines @ Direction
Reference baffle line: A |Shape 1 <192>:Ed ~ | b
|E’3"'ﬂE Lines 2 V| i B Reference plane
Additional baffle lines: IShape1 <192=:Face(¥ V| qr I
Baffle Lines 1 (] Depth
Baffle Lines 3 U
Offset:
[ Hide [émm v
Rounding:

<unspecified> x

Drilling distribution wizard

The new Drillings Distribution Wizard command is available in a cooling sketch. It distributes drillings over a
profile enclosing the parts to be cooled. Drillings are distributed with a minimum distance between each one, while
framing the elements to be cooled (in pink) and avoiding, with a margin, the elements selected in yellow.

o o o 2 = =]
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The wizard does not create any commands in the cooling sketch that can be modified later. This generates a sketch
that can be modified in the cooling sketch solving, by modifying and/or adding constraints.

Baffle line distribution wizard

The new Baffle Lines Distribution Wizard command is available in a cooling sketch. In the same way as the drilling
distribution wizard, it allows you to distribute baffle lines on profiles. The baffle line distribution area is defined by a

silhouette with margin of the parts in the molded set.

Drillings are distributed with a minimum distance between each, while framing the elements to be cooled and
avoiding yellow elements with a margin.
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The wizard does not create any commands in the cooling sketch that can be modified later. This generates baffle
line points that can be modified in the cooling sketch solving.

Cooling circuit process
Previously, the color of the cooling circuit was transferred to the faces resulting from the cooling process.

In version 7.18, the new Apply circuit color option, available in the advanced options, allows the color of the cooling
circuit to be applied to the faces resulting from the process.

@ Advanced Options

Representations

O Al
() Detailed

Machining process
Document:

<unspecified> -

Process:

B8 Apply drcuit color
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Sprue bush

The new Sprue Bush command allows you to include a sprue bush type component. The sprue bush is sized
according to the mold environment and automatically limited to the desired length.

In addition, a runner shape matching the plastic material in the sprue bush has been defined in the sprue bush
components. It is automatically taken into account when creating the plastic sprue.

Sprue Bush Management (E 1600 /24 = 56/ 5

Manufacturer:
Meusburger w
Family:

" E 1600 - Sprue Bush 1° without Radius w
Code:
B Use best code

Trimming type:

Plane v

Cirevit d'alimentation 1 <12387> Face(26) w | d

Sprue bush sizing and limitation
with the new Sprue Bush command.

Plastic sprue

The runner shape is automatically limited with the sprue bush.

The new Plastic Sprue command automatically creates the mold's plastic sprue.

A part document is created, containing the union of molded set parts and runner, as well as runner shapes declared
in sprue bush components. This allows you to create more precise plastic flow analysis of plastic injection.

v % ?

@ Results Display

Flow Front - Time When Filled <

0
il a p i

Filling time:
[p.2433165 |

Filling total time:
3713775 |

Filling level:

[65.517242% |
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Gate

Initialization of settings

To facilitate and speed up the creation of similar gates, you can initialize the parameters and settings of the Gate
command, based on those used to create the first gate.

Simply select a face from the first gate before launching the command.
Angle pin

Process on slide

The machining created by including the angle pin in a slide can now be performed with a chamfer-type blend. It is
also possible to apply a machining process to the faces machined in the slide.

Angle pin process with chamfer-type blend. Machining process on the angle pin process in the slide.

Initialization of settings

To facilitate and speed up the creation of similar angle pins, you can initialize the parameters and settings of the
Angle pin command, based on those used to create the first angle pin.

To do this, simply select a face from the first angle pin before launching the command.
Springs

Initialization of settings

To facilitate and speed up the creation of similar springs, you can initialize the parameters and settings of the
Springs command, based on those used to create the first spring.

Simply select a face from the first spring before launching the command.
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Drafting

Cooling circuit style

In the drafting context, the cooling circuit style offers new categories for fine-tuning the attributes of different

cooling circuit lines.

For cooling drilling lines, visible and hidden lines are differentiated. The same applies to cooling component lines.

100

Cocling drilling visible lines
Visibility:
Visible

B Attributes:

[ Half tone

Layer:

Cocling drilling hidden lines
Visibility:

Wisible

B Attributes:

(I Half tone

Layer:

Cocling component visible lines
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TopSolid'Electrode

Set attributes

From now on, only surface shapes can be added to the Shells set, only solid shapes can be added to the
Eroding Shapes set and only parts can be added to the Electrodes set.

In the Electrodes document’s Options tree, the new Electrodes > Attributes > Sets category allows you to assign a
color and/or transparency to shells when they are included in or removed from the set.

Shells inclusicn
Color:
Transparency:
Shells deletion
Color:
Transparency:

You can also predefine attributes for the Eroding Shapes and Electrodes sets.

Eroding shape

Initialization of settings

To facilitate and speed up the creation of similar eroding shapes, you can initialize the parameters and settings of
the Eroding Shape command, based on those used to create the first eroding shape.

Simply select a face from the first eroding shape before launching the command.
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Electrode

Initialization of settings

To facilitate and speed up the creation of similar electrodes, you can initialize the parameters and settings of the
Electrode command, based on those used to create the first electrode.

To do this, simply select a face from the first electrode before launching the command.

Theoretical positions

In the Electrodes document’s Options tree, the new Name positions option allows you to name the different
theoretical positions of an electrode by defining a prefix.

Positions are named in the set of theoretical positions related to the electrode. You can modify their order by
moving positions within the set. The electrode position number depends on its position in the list.

Electrode
Margin for base computing:
|m V| =l () Sets

'-v’i Shapes To Burn 5et 1
= '-v’i Electrodes

SEC R

rg'{ E-01 <Position n*1=
=) 4%} Theoretical Positions (E-01)
®  E-01 <Position n*4s

Margin for steck height co...

Smm

Initial positions
Securiry margin:

>mm B E-01 <Position n°3>
Thecretical positions i
B name positicns

Prefix:

|F'05itior1 n° |

The new Construction > Patterns > Pattern Optimization command modifies the order of positions in a pattern
to optimize the path between the points of this pattern. The positions of the theoretical electrodes created with an
optimized pattern will then naturally be ordinated in this order.

Electrode wizard

Initialization of settings

To facilitate and speed up the creation of electrodes of the same type, you can initialize the parameters and settings
of the Eroding Shape and Electrode commands launched by the wizard.

Simply select a face from the first electrode before launching the command.

Electrode/mandrel assembly process

The Work document features the new Electrode/mandrel assemblies process that automates the generation of
assembly documents. This automated system creates an assembly document for each electrode featured in the
Electrodes document and incorporates both the electrode and its corresponding mandrel.
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TopSolid'Strip (Strip design)

Strip

Imprint section

In the advanced options of the Strip command, the new Imprint section option allows you to imprint a section
around each station during strip creation, reducing computing times when creating punches.

The section must be drawn around the shapes to be striped.

When the Imprint section and With simplified skeleton advanced options are coupled, it is possible to improve the
overall creation time for the strip and its punchings by around 50%.

Without thickness

In the advanced options of the Strip command, the new Without thickness option creates a surface strip. This
allows you to create strips from surface station shapes for quotations, for example.
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TopSolid'Progress (Progressive die)

Head

Initialization of settings

To facilitate and speed up the creation of similar punch heads, you can initialize the parameters and settings of the
Head command, based on those used to create the first head.

Simply select a face from the first head before launching the command.

Springs

Initialization of settings

To facilitate and speed up the creation of similar springs, you can initialize the parameters and settings of the
Springs command, based on those used to create the first spring.

Simply select a face from the first spring before launching the command.
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This chapter describes what's new in the sheet metal machining application of TopSolid 7 software in version 7.18.

Microtabs

Evacuation rules document

Important changes have been made to the microtabs, including the introduction of the new Evacuation Rules
document. This document allows you to define a microtab width based on a range of thicknesses. Additionally,
it specifies the number of microtabs considering both the size of the selected element and the perimeter of the

chosen contour.

T
1 1| New Document

Type:

| Common ” Advanced ” Special

vz

by

b

Classification

gﬁ-j' Box Margins Rules

Clearance Hole Standard

Cut Technology

Enumeration

Envircnment

Evacuation rules

¥ Finishing

Functicn

MF post processin
PDF Template
Piping Rules

Cylinder Margins Rules

;E‘ Machining Processes

’_: Material Equivalences

grules

Dimensicnal Tolerance Standard

Project:

Micro-attache

Termnplate:

O_J Project Templates
C’_J My Templates
7] Standard Templates
(’_J Machining Standard Ternplates
Z’ Medéles standards
C’__f Modéles standards Usinage

E= Blank Template

v X ?

The Evacuation rules document is presented as follows and can be completed according to your preferences.
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SeartPage | %> Evacuation rules 1 ¥ X
Micro tabs |
Materisl  Gas dh = Material
» x Category,
Carbon steel -
Document
| @ steel -
= Gas
Document
Thicks WMicro tabs width )
»
2mm 0,5mm %
[Smm. mm.
| 10mm [1,5mm
Length Micro tabs number &5
>
Somm |1 x
200mm 2
Peiimeter  Micro tabs number &b
»
200mm 2 x
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Once the document has been completed and saved, it can be selected in a sheet metal CAM document, via the
Management > Micro Tabs Management command.

ﬁHome -;Equfpment ¥ =@ Management |¥ = Cutting # | &% TubeCutting # 75 Axis Cu

@ &8 &

suoielsdg 5y

&

sanRu3

Start Page |#F Evacuation rules 1

4 Sheet

suoneadg Dy é

AT

=8 bg FEHL A

o & i

ni ]
T

Standard leads...

Unit Part Management...

Leads management...

Corners Processing Management...
Micro tabs management...

Cuttings Management...

Links Management...

Path optimizing management...

Common cuttings management...
Waste cuttings management...

Skeleton cutting management...

Burning...

Drilling...
Checkings...

Clamps Position Management...

For the evacuation rules document to be available for selection, its location must be referenced in the current

project.

m Micro Tabs Management X

%% Evacuation rules

| R

%% Evacuation rules 1

<unspecified>

Micro tab width

0,2 mm

Internals

Lecation 3¢ Mone

Externals

Location S MNone

In the evacuation rules document, length and perimeter rules are used by choosing to apply microtabs distributed
over each segment for length and distributed over the entire contour for perimeter.
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m Micro Tabs Management X

% Evacuation rules
|§ Evacuation rules 1 v|

Settings
Micro tab width

0,2mm

@ Internals
Lecation Q Distributed along contour
Micro tabs count
2

@ Externals

@ Distributed along segment

Location

Micro tabs count
2

What's New in TopSolid'Cut 7.18

An icon matching the evacuation rules is displayed in the Micro Tabs option from the Automatic Machinings
command or in the Micro Tabs command. It indicates that microtabs will be allocated according to the parameters

defined in the evacuation rules document. If the icon does not appear, the value displayed is the one set in the
Micro Tabs Management command.

& eSd SBam Vvl

i
O ) - =c- < < ccoicn s (721
[it1] Setti _

) Sertings v e ?

[ Force micro tab width
0,3mm

[ Internals

Location  §_} Distributed along contour

El

[ Force micro tabs count

] Externals
Location  §_) Distributed along segment

[ Force micro tabs count

TopSolid

i

VOB OO
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Positioning microtabs

New modes for better positioning of microtabs are available in the Micro Tabs Management and

Automatic Machinings commands.

m Micro Tabs Management X

%% Evacuation rules

|f§- Evacuation rules 1

- |

1| Settings
Micro tab width

0,2 mm

Internals

Lecation Q Distributed along contour

Micro tabs co x MNone

2
D Only one
Externals
@ Distributed along segment
Location

Q Distributed along contour

m Micro Tabs Management X
%7 Evacuation rules

|ﬁ- Evacuation rules 1 v|
ﬂ Settings

Micro tab width

0,2mm

Internals

Location € None

Externals

Location & None

x MNone

Only one

In corners

Distributed along segment

Distributed along segment and in corners
Distributed along contour

Distributed along contour and in corners

OO0 DD

New configurations are also available, giving you more possibilities for positioning the microtabs.

m Micro Tabs Management X

%" Evacuation rules

| %% Evacuation rules 1

- |

l_'-l Settings
Micro tab width

0,2mm

Internals

Location D Only one

Other contours D Optimized
Rectangles Ej Optimized
Oblongs () optimized
Circles ("} optimized
Omm < Contour Size < 200mm
Externals

Location H None

108

m Micro Tabs Management X

%7 Evacuation rules

|ﬁ- Evacuation rules 1

- |

[i11] Settings
Micro tab width
0,2mm
Internals
Location D Only one
Cther contours D Optimized
Rectangles Ej Optimized
Oblongs () optimized
Circles () optimized
Ormrm < Contol 0 Optimized
Externals O Top
Location x None Q Bottom
O
O Right
O Best of the four

TopSolid



Automatic machining

Cut preview

What's New in TopSolid'Cut 7.18

A cut preview is now available in the Automatic Machinings command, allowing you to preview the future cut and
see the result of the operation in advance.

@ Home | & Equipment ¥ T@Management ¥ =i Cutting ¥ f TubeCutting ¥ #75AxisCuting ¥ 4 Punching ¥ [ENesting ¥ |-=fAdditional ¥ [¥Operation ¥ “FVerify #WorkManager & mslVisualization ¥ Y Analysis ¥ 7 Construction ¥ | %
NA LG i i | W
Start Page |7 Chameleon™

?

LT & BB Uy
eometries

7 Machinings
ANVESREE
[3 Selection

2| Abc

= W A

_& Profiles path optimization

Sequence Entire sheet
Start Bottom left
Progression direction ++ Horizontal
Strateqy 27 shortest
Machinings pricrity 3 None

[ Recalculate current links
' On profile start point location

Hooking ] Picking

Internals

Circles () optimized
Oblongs ) optimized
Rectangles [ optimized
Other contours L optimized

() Focus an comers

Externals
Contours 7] optimized
Adjustment K MNone

(] Focus on comers

(] Aveid arcs

IR
il =

v K&

HOOO

8

(DIC)

The different numbers represent the machining toolpath, with 1 corresponding to the starting point.

@ Home @ Equipment ¥ < Management ¥ < Cutting ¥ 4% TubeCutting ¥ |75 AxisCutting ¥ | & Punching ¥ |ENesting & i Additional ¥ $§Operation ¥ ~fVerify #FWorkManager ¥ mMlVisualization ¥ " Analysis ¥ | 2 Construction = %

ZITEREE | %
Start Page | {7 Chameleon™
v X ?

& T & B vy

# Machinings
e iai
Z I sl E:
I3 Selection

5 0] < Abc

Type W An

_& Profiles path optimization

Sequence Entire sheet
Start Bottom left
Progression direction ++ Horizontal
Strategy 27 shortest
Machinings priority ¥ Mone

[ Recalculate current links
‘¥ On profile start point location

Hooking K] Picking

Internals

Circles () optimized
Oblongs () optimized
Rectangles [ optimized
Cther contours L} optimized

() Focus on comers

Externals
Contours 5] optimized
Adjustment. & None

() Focus on comers

[ Avoidarcs

TopSolid

HROQO
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What's New in TopSolid'Cut 7.18

Start point

Starting point configuration is now possible for both internal and external contours.

You can customize the starting point from different shapes. These new options also work with leads.

% On profile start point location

Hooking ﬁ Picking
Internals

Circles () optimized

Oblongs O Optimized

Rectangles O
Other contours Q
] Focus on corners
O
Externals
O Right

Contours

Adjustment Best of the four

[CJ Focus on corners

[T Avoid ares

™ On profile start point location

Haooking @ Picking
Internals

Circles () optimized
Oblongs () Optimized

Rectangles { .} Optimized
Other contours @ .
Line

[[] Fecus on corners

Externals
Q} Best of the four
Contours
Adjustment x None

[ Focus on corners

[ Avoid arcs

It is also possible to configure these options in the Cuttings Management command.

@ Home |8 Equipment ¥ @ Management |¥ | < Cutting ¥ &7 TubeCutting ¥ #75 AxisC

g i 5 3 |. %= Standard leads...
[}I’_Stﬁage{ﬁ \Ej - “i  Unit Part Management... |
o ‘g Leads management...

'r@nr If, Comers Processing Management...
g iﬂ, Micro tabs management...

g Lm  Cuttings Management...

g gl Links Management...
= 44 Path optimizing management...
E % Commeon cuttings management...
8 [ Waste cuttings management...

E [1} Skeleton cutting management...
21
g. Burning...
< Drilling...
©  Checkings...
Clamps Position Management...

g Geometry b4

™ On profile start point location

Hocoking ﬁ Picking
Internals

Circles () Optimized
Oblongs (C) Optimized
Rectangles I:j Optimized
Other contours L—L‘j Optimized

[_] Focus on corners

Externals
Centours L—L‘j Optimized
Adjustment x None

[[] Fecus on corners

[] Avoid arcs

Note that in all cases, concave corners are systematically avoided. If the point selected by TopSolid is a concave

corner, the nearest key point is automatically preferred.
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What's New in TopSolid'Cut 7.18

Machine stop

You can now add machine stops to almost all 2D cutting elements. To do this, right-click on a cutting or other 2D

cutting element and select the Add Machine Stop command from the context menu. The machine stop is then
positioned on the starting point for cutting.

The machine stop is represented by a red square. It can be deleted via the context menu.

TopSolid 1M1



What's New in TopSolid'Cut 7.18

You can also add a machine stop manually, directly from the Evacuation option.

8 Home @l Equipment ¥ <@ Management ¥ = Cutting ¥ | &7 Tube Cut

% K

L=

" Ejecting b4l Start Page

el b e |F RVA%ZY

“%r Evacuation

Evacuation type H None

Fy

% MNone

. Machine stop

Machine stops can also be added to links.

B Home @ Equipment ¥ T@Management ¥ =i Cutting ¥ 4 Tube Cut

: | [ (w0 | 1'%
> | [ e < % 1= 70
(! Head state

Head State r(] Head up

Rise Value When Head Is Up

40mm

Head state (Micro Tak) ~" Head down

Rise Value When Head Is Up (Micro Tab)
40mm

[0/ Smooth link

Radius computing 1| Automatic
Radius at start

Smm

Radius on passing point

Smm

Radius at end

Smm

/1, Dangerous links resolution

Resolution type £ None
“%r Evacuation
Evacuation type £ None

% None

. Machine stop
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Marking

Counters

What's New in TopSolid'Cut 7.18

Marking has been improved and offers two new options: Global counter and Global counter per part.

; e Content

| Mode:
: Mesting e
Type Value
Global counter = | Double-click to modify options
» Global counter per part Al Double-click to modify options

Command (Task)
Custom text
Customer (Task)
Global counter
Global counter per part
Part description

Part name
Part number

To set the counter format, simply double-click in the cell. It is then possible to define the minimum number of
characters and the completion character.

&I Marking notes O X
Minimum char number:

1 =
Default char:

0

Example:
1

W ¥

These options are only available in a nesting context, i.e. in the document template in nesting mode or in a
document resulting from nesting.

The global counter increments parts without distinguishing them, while the global per part counter simply numbers
each part type from 1 to N. The counters induce a dependency of each sheet metal part from those preceding it in

the nesting.

In addition, the new Update Nesting all Marking Notes command forces the recalculation of all nesting marking
operations. It is only available in the Additional menu of the machining document.

TopSolid

=i Additional 5 Operation & | ¢ Verify ﬁ-WorkMana

Virtual Jog...

'°ﬁ’$ 4l

.

Control Points...
Stock Modification... B

Environment Management...

#i 4

Machine Elements Activation...

p'_? 44

Part Repositicning...

Delete a Part Repositioning...
Extract Machined Part Stock...
Machining Sketch...

Wire Text...

Marking notes...

Wastes marking notes...

B @z N &

Update nesting all marking notes
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What's New in TopSolid'Cut 7.18

Marked nesting with the global counter.

Waste marking notes

The new Wastes Marking Notes command is available in the Additional menu of a template document or a sheet
metal cam document coming from a nesting, if a waste cutting operation has been performed.

%] AR % %S| LB

Several options are available for writing.

Box dimensions

Date

Global counter

Glebal counter per date
Material

Thickness

Here is the format for the elements used to indicate the date:

* dd matches the day;
* mm matches the month;
* yyyy matches the year.

% Wastes marking notes = O *
Format:
dd/MM/yyyy

Example:
10/10/2023
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What's New in TopSolid'Cut 7.18

The order of the elements can be customized from your requirements.

I # Wastes marking notes O e
Format:
wyy/MM-dd

Example:
2023/10-10

# Machining Sketch Ent...

Type

Material

Custom text -

Thickness - | Double-click to modify ..
Custom text - |-

Box dimensions - | Double-click to modify .. N
Custom text - - .
Glebal counter = | Double-click to modify ... i

Margin {min):

2mm

T

Manual position:

Part Posi.. XP.. YP. Size Angle  Ignore

T

i)

Drivers

S1eel-1,0-1100,00x 1000,00- 001

Example of waste marking.
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What's New in TopSolid'Cut 7.18

Work document

Reexecution

The new Reexecute option is available in the Work document.

|§} Work ”ﬂf Processes ”@ Results ||| Review |
Selections
Available processes: Processes to apply:
TopSclid'Cam Bills of material (TepSclid' Design) (BOM - Tache)
TopSelid'Cam SheetMetal Unfeldings (TopSclid'Design) (Mises & plat/ Bom t
TopSolid'Design :|r> SheetMetal Cam (TopSclid'Cam SheetMetal) (Toler
TopSelid'Drafting MNestings (TopSclid'Cam SheetMetal) (Imbrications :
TopSclid'Interop
TopSelid'Interop Acrobat
TopSelid'interop AutoCAD
TopSelid'interop Fbx
TopSelid'Interop Ifc
TopSelid'Interop Spatial
TopSelid'WorkManager
Executions
Process State Result Messages
Bills of material (TopSolid'Design) (BOM - Tache) Executed Success
Unfoldings (TopSolid'Design) (Mises & plat / Bom tac... |Executed
SheetMetal Cam (TopSolid'Cam SheetMetal) (Tolerie ... |Executed
Nestings (TopSelid'Cam SheetMetal) (Imbrications 1) Executed
r

It operates on the following principles:

* If a document has already been created by the previous execution, it will not be recreated, but simply
updated. Updating may involve a simple replay of operations, or the launch of additional operations.

* If a document is missing, it will be created and processed like a classic execution. For example, if you
generate a drafting from an assembly BOM, and you have added parts to the assembly, new draftings will be
created for the new parts.

* If a document must be deleted, it will be. For example, if you generate a drafting from the BOM of an
assembly, and you have deleted parts from the assembly, the draftings for these parts will be destroyed.

Multiple selection

Multiple selection is now possible in the Results tab.
Start Page |f8F Work 1 %6 [Te7 (S 8 (71 72

[ Wok [of Processes | Resuls ||  Review |
) oo allio ) B O
Display: 7 E ]7/ 2 Filter by process: No filter V‘ |J_E| !
Document Action Quantity  Requested qu.. Description Process Process message

‘ 1 Unfoldings (TopSclid Design) (Unfoldings 1)

% 2 Unfeldings (TopSelid Design) (Unfoldings 1)

B% 3 Unfoldings {TopSolid'Design) (Unfoldings 1)
Unfoldings {TopSolid'Design) (Unfoldings 1)
Unfoldings {TopSolid'Design) (Unfoldings 1)
Unfoldings {TopSoli i

n'

Open Document

SheetMetal Cam (TopSolid'Cam SheetMet eetMetal Cam 1)
SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
SheetMetal Cam (TopSolid‘Cam SheetMetal) (Shesthetal Cam 1)
SheetMetal Cam (TopSolid‘Cam SheetMetal) (Shesthetal Cam 1)
SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
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What's New in TopSolid'Cut 7.18

Displaying invalidities

Error messages associated with processes now pinpoint the problematic document(s) for clearer identification.

5% Work ”nf? Processes ”@ Results ||| Review |
Selections
Available processes: Processes to apply:
TopSolid'Cam Unfeldings (TepSolid' Design) (Unfoldings 1)
TopSolid'Cam SheetMetal SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
TopSolid'Design Mestings (TepSclid'Cam SheetMetal) (Nestings 1)

3]

TepSolid'Drafting
TopSolid'Interop
TepSolid'Interop Acrobat
TopSolid'Interop AutoCAD
TopSolid'Interop Flx
TopSolid'Interop Ifc
TopSolid'Interop Spatial
TepSolid WerkManager

>

e

Executions

2 X2

Process State Result Messages Dura...

Unfoldings (TopSelid'Design) (Unfoldings 1) Executed Success 1,96
SheetMetal Cam (TopSclid'Cam SheetMetal) (SheetM... |Executed
Mestings (TopSolid'Cam SheetMetal) (Mestings 1)

By clicking on the error message (the red line), the window below appears and displays the list of incorrect
documents.

Process messages O x

Messages:

Type Message Document Date

v

You can open documents via the Open documents associated to messages context command.
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What's New in TopSolid'Cut 7.18

Executions

3 12

Process State Result Messages Dura...
Unfeldings (TopSclid' Design) (Unfoldings 1) Executed 1,96

SheetMetal Cam (TopSclid'Cam SheetMetal) (SheetM... |Executed Failure
Mestings (TopSclid'Cam SheetMetal) (Mestings 1)

Show process results

Open documents associated to messages .

‘ Check process results

Declared as fixed...

Error messages are also present in the new Process message column from the Results tab.

2 Work ”dz: Processes HE]_ Results ”\ Review ‘
E 3 e
Display: 5 g_/ ]§_/ .’l“}_/ £ Filter by process: Na filter v‘ .ﬂ Dﬂ ]—# 1E
Document Action  Quant.. Requested quant.. Descripti.. Process Process message
‘ 1 Update |1 Unfoldings (TepSelid'Design) (Unfoldings 1)
% 2 Update |1 Unfoldings (TopSelid'Design) (Unfoldings 1)
% Update |1 Unfeldings (TopSelid'Design) (Unfoldings 1)
‘ 4 Update |1 Unfoldings (TepSelid'Design) (Unfeldings 1)
‘ 5 Update |1 Unfoldings (TopSalid'Design) (Unfoldings 1)
®s Update |1 Unfeldings (TopSelid'Design) (Unfoldings 1)
‘ 7 Update |1 Unfoldings (TopSelid'Design) {Unfeldings 1)
2% 8 Update |1 Unfoldings (TopSolid'Design) (Unfaldings 1)
a1 Update |1 SheetMetal Cam (TopSelid'Cam SheetMetal) (SheetMetal Cam 1)
= T2 Update |1 ShestMetal Carn (TopSolid'Camn Sheethetal) (Shesthetsl Cam 1) _
&h 3 Update |1 SheetMetal Cam (TopSelid'Cam SheetMetal) (SheetMetal Cam 1)
H{® 4 Update |1 SheetMetal Cam (TopSolid'Cam SheetMetal) (SheethMetal Cam 1)
=12 Update |1 SheetMetal Cam (TopSelid'Cam SheetMetal) (SheetMetal Cam 1)
&h [ Update |1 SheetMetal Cam (TopSelid'Cam SheetMetal) (SheetMetal Cam 1)
B4 7 Update |1 SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
e Update |1 SheetMetal Cam (TopSolid'Cam Sheethietal) (Sheethetal Cam 1) —
F % Steel ITmm | Creation | 1 MNestings (TopSelid' Cam SheetMetal) (Mestings 1)

You can choose to display or hide this column, and define its position via the configuration of processing result
columns command.

Error correction management

The new Check process results command enables users to check a process after implementing corrections. It can
be accessed from the context menu on an invalidity.

Executions
Process State Result Messages Dura...
Unfoldings (TopSelid Design) (Unfeldings 1) Executed 1,68

Show process results

Nestings (TopSolid'Cam ShesthMetal) (Nestings 1) Open documents associated to messages

Check process results

Declared as fixed...

If all errors are corrected, the process returns to Success state and execution can continue.

In other cases, or when the error correction cannot be verified, it is always possible to declare the process as
corrected.
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Executions

&S
Process State Result Messages Dura...
Unfoldings (TopSclid'Design) (Unfoldings 1) Executed 1,68

Show process results

Nestings (TopSolid'Cam ShectMetal) (Nestings 1) Open documents associated to messages

Check process results

Declared as fixed...
3 Work ”c? Processes ”E Results ”| Review

Display: T Filter by process: Nofilter < BRI

Document Acti.. Quant.. Requested quant.. Descripti.. Process Process message
Update |1 Unfoldings (TopSelid'Design) (Unfoldings 1)
Update |1 Unfoldings (TopSalid'Design) (Unfaldings 1)
Update |1 Unfoldings (TopSelid'Design) (Unfoldings 1)
Update |1 Unfaldings (TopSolid'Design) (Unfoldings 1)
Update |1 Unfoldings (TopSelid'Design) (Unfoldings 1)
Update |1 Unfoldings (TopSelid'Design) (Unfoldings 1)
Update |1 Unfaldings (TopSalid'Design) (Unfaldings 1)
Update |1 SheetMetal Cam (TopSeolid'Cam SheetMetal) (SheetMetal Cam 1)
Update |1 Sheethetal Cam (TopSolid'Cam SheetMetal) (SheethMetal Cam 1) _
Update |1 SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
Update |1 SheetMetal Cam (TopSeclid'Cam SheetMetal) (SheetMetal Cam 1)
Update |1 SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
Update |1 SheetMetal Cam (TopSeolid'Cam SheetMetal) (SheetMetal Cam 1)
Update |1 SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1)
Update |1 SheetMetal Cam (TopSolid'Cam SheetMetal) (SheetMetal Cam 1) —
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What's New in TopSolid'Inspection 7.18

What's New in TopSolid'Inspection 7.18

This chapter describes what's new in Process, Ergonomics, Indicators and Interface for
TopSolid'Inspection Creator, Controller and Analyst applications in version 7.18 of TopSolid 7.

Process

Customizable additional data

Additional data such as free text, choice lists and image lists can be customized and complete the control plan at
the checkpoints and measures levels, to take into account the specific features of your quality processes.

__‘|_'_ _\IQ ' User-defined lists Customization
Target Type Label Image
= Checkpaint Image list 1 W1 .&
Checkpaoint Image list 1 W2 &
Checkpaint List 1 BC
Checkpaoint List 1 KC
Measure Imaage list 1 STOP1 0
Measure Image list 1 STOP2 ®

PDF annotations

Annotations such as text, images, shapes, signatures and dimension lines can now be added to PDF drawings,
providing the workshop with added value drawings containing all the information required for the checkings to run

smoothly.
\ S S

9/7/2023 8:49 AM

1
1
1
|
|
|
|
|
1
1
1
1
|
|
|
I
|
|
L
I

2js9 @ 40h6

COUPE A-A

Warning

@ 14h7

+0,2
163 0
JQOO
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What's New in TopSolid'Inspection 7.18

Linked and theoretical exact dimensions
Improvements have been made in order to avoid unnecessary checkings.

The principle of linked dimensions allows you to link several dimensions together to minimize the number of
checkings and manage theoretical exact dimensions.

Measuring a non-ISO GPS linked dimension applies the same conformity status to associated dimensions with an
equal or greater tolerance deviation.

Measuring an ISO GPS geometric tolerance applies the same conformity status to the associated theoretical
dimensions.

Project features a x B10292785-220E-X.PDF Demo P ROS00 0346 002.PDF
“lEE 8 1 Joft @ & Q- \ ™ -] = BRI =
I |
|
0 7 H
Unit ® mm inches @
T}
Ne image data N
[ | o~
[ No image data N
v
4 » 4
Creation view: list of checkpoints
+ View Link  Phase .. C.. |B..| Seco.. Locati.. | Acro_ | Value Fit Unit | Upp. t.. |Low. t.. Upp.v.. Low. val.. Equipment 1 Equipment 2
R AR T [Fle 0.05]a] mm | 00500 00000 0.0500  0.0000
gi ©  Measur... Part # Serial # Controlled value Deviation OK [NOK Status User Measure date Comments Instrument 1 Instrument2 | Ir
2 2 = 14142000 12000
Gen
3 3 = 14142000 12000
+ ‘
& - E & 2 mm 2 mm | D0DD0 0ODO0 225000 225000
®  Measur. Part # Serial # Controlled value Deviation OK [NOK Status User Measure date Comments Instrument 1 Instrument 2 | Ir
=1 1 = 10/9/2023 5595 | =1
2 2 = 14142000 12000
3 3 = 14142000 12000

Measurement accuracy

Constraining a measurement accuracy on a dimension prevents lower accuracy inputs. The control means can be
parameterized to enforce a specific degree of accuracy and adhere to quality requirements.

Phase code: | P-10 Phase label: | Phase 10 Machine: -

Part P-10 Balloon

1 - PAC1 -
— <

Expected value 0K MoK
Acronym: @& Unit:  mm Freguency: 7 g
40
o -0.015 39.984 | 38
The precision of the measurement does not respect the number of decimal places defined.
Spedify your input.
Text 1 Text 2 EC/KC List 2
Instrument 1: = | Instrument 2: = | Instrument 3:
| I 1
® ) OK MNOK ‘ 0,01 ‘ Status: B8 - [
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Ergonomics

Filtering checkpoints

In the main program and in the Controller interface, a filtering system has been implemented for the dimensions to
be checked. This facilitates reading, selection from grids and measurement session organization.

w Data filtering - O »

X

Close  Validate

|
Action
| Par.. T Status T Comments T Seral# T
|
= | - 1 K =
S|, T Phase T|. T T T L. T _ T vaue Y .. Y Upp.tole.. T Lo.. Y Low... T Upp.. T | Equipment1 Y Equip.. YT Equip.. Y | Equi
= Phase 10 HEE 1 20 mm 0.2000 -0.2000 15.8000 20.2000 | Pied & coulisse
Phase 10 HE 2 20 mm 0.2000 -0.2000 15.8000 20.2000 | Pied & coulisse
4 >
% |+ | | Phase = Phase 10 And Equipment 1 = Pied a coulisse - Edit Filter
+ 2 E1
+ 3 Bl
+ 4 [
+ 5 Bl

Masking balloons and drawing dimensions

A new feature allows you to "clean" the part drawing with a single click, making balloons and dimensions invisible so
that you can more easily assess the remaining items for ballooning ensuring that nothing is overlooked.

16

17,
1
2 >3 =
5 b -
3 15 ] | ,
) -
I
998 <
: |
11 /; e
CH 1a45”
VOIR_DETAIL VOIR_DETAIL
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Virtual keyboard

Avirtual keyboard for numeric input is now available in Controller, facilitating numerical dimensions

inputs through the touch screen without using the Windows keyboard.

17 TopSolid'Inspection Controler 7.18.309.2 - User-Test - o X
Project =Y 1 ofi @ @& Av -
Part #: Rev.: Qty: 0
Descr: YT
4
Phase code: | P-10 FPhase label: | Phase 10 Machine:
- 100
Part P-10 Balloon :
— PACZ -
: - -
* 0K NOK
Expected value 53—-—
= 2
Acronym: Unit: | mm Frequency: 7 20 20
Equipment 1: - | Equipment 2: ~ | Equipment 3: - | Equipment 4:
f - i
20 | <]
= )
0.2 0.2 19.8 20 | 0.2 | by
TYPE i\
. o
Text 1 Text 2 ECKC List 2 i el
Instrument 1: + | Instrument 2: ~ | Instrument 3: ~ | Instrument 4: = Prog. No.: [+
- m - -
-
Measured value: o v = 16

° 0K NOK. | Ei,l'l! ‘ Status: =E -
Comments: - -
Text1 Text 2 List 1 - |List2 -
= —
R2,5
201
< -

|
) 4 (3

I [EN 5N I I N
I I X I I I

Naming convention

To make it easier to save projects and exported documents, a naming convention can be activated and
parameterized to define automatic rules for ITL project, ballooned drawing, report export and Excel export file

names.

" Naming convention = m} x

¥ X

validate Cancel

Actions
| [ Display “Save as” dialog if PDF drawing exists Index
B Froject 2
| @ Customer 1
B Reference 3
I B Revision 4
;[jPONm
[[] Order Na.

[[] Designation 1
[[] Designation 2
| [[] Designation 3
| [[] Designation 4
{ [[) Designation 5
. ] Project modification date

] Today's date

Mass modifications of checkpoints
The properties of a checkpoint selection can be modified all at once.

TopSolid
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Drawing display in project creation

The selected drawing is displayed in the project creation, making it easier to acquire information
from the drawing at the image and text levels.

Project sheet

Y X &

Vvalidate Cancel CAD drafting

Actions CAD import
Customer: TOPSOLID [, ) 1 joft @ & Q- »n ™
Part #: B69542335
Drawing revision: A Qty to produce: 0 Qty to inspect: 7
PO No.:

Order No.: () Image File
File path: D:\07 - PLANS\B10292785-220E-X.PDF ® |Browse
Project: B10292785-220EX Unit: *)mm inches
Description 1: Cylinder 14/40
| Description 2:
| Description 3: Creation date: 9/7/2023
| Designation 4 Modification date: 9/7/2023
Designation 5: User: Test
Serial number
Prefix: Selfincremented variable number: Sufix:
\
WO 4 4 Record0ofD » o4 3
Default parameters
Default balloon size: 4 Defauit balloon color: - galloan shape: [} Cir.. - |Transparency: | semi-transparent
Display box | Display link
Secondary balloons
Number / Secondary separator . | Display box for secondary balloons
®) Alphabetic index Numeric index
Display format @)@ 5. - |[|Display link for secondary balloons

Default general tolerance: | 1SO 2768-m

Individualizing balloons components

To further customize the layout of the ballooned drawing, you can update, for each balloon, the display of the
border, link and label.

7 Balloon remote control X

2 Balloon
| Box Transparency: |Semi—transparent v| |
Balloon font size: |4 ~
| | Redraw box : ;'. | |
| Balloon color: [ ] - || - |||
| | Offset (pixel): 5 |
. Balloon rotation:
- | Display box

< D =

v Display format | @2} @) Secon.. -

- | Display box

+ | Display link
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User, password and signature

What's New in TopSolid'Inspection 7.18

Username input assistance is available in connection patterns of the different programs, to

simplify connection process.

Users can associate two signature images with their profiles. These are available in the editions as well as in the

annotations of PDF files to sign the drawing and the reports.

To enhance security, users are required to input their password twice in the user management section.

w User

¥ X

| validate Cancel

Actions
| Login: Liser]
| Display name: Test
i Password: senee

Confirm password: | sesss

| Access role: Administrator

| View type: Both views - [:]

= m] x

| [The Administrator role has all rights in the application.

i |settings.
to the creation of a project or to the settings.

access to the creation of a project or to the settings.

Picture image: D:\50 - DRIVEYOneDrive - TOPSOLID SAS\Images\profil.jpg

Signature image:

Project search system in Controller

D:\50 - DRIVE\OneDrive - TOPSOLID SAS\Images\signature.png

IThe Manager role has all rights in the application except the path settings and user management.
| [The Builder role can create a project and select and create checkpoints on the drawing. It does not have access to the

| [The Controller without blocking role can create measurement lines and correct measurements, Tt does not have access
IThe Controller with blocking role can create measurement lines without the ability to revert to them. It does not have

[The Analyst role is used in the TopSolid Inspection Analyst application for statistics and control charts.
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The Controller interface integrates a project search system to facilitate the availability of projects for workshop

inspection.
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What's New in TopSolid'Inspection 7.18

Managing the display of report templates

When TopSolid'Inspection is opened, the REPX files from the \Template directory are copied to

the param files path. This displays a large number of templates in the printing windows. In order to

display only the templates you need, you can rename the REPX files you don't need in the \Template directory by
adding the "_" character (underscore).

Mass deletion of checkpoints

In order to speed up the creation of control plans, the deletion can involve several selected checkpoints.

Modification of measurement data

A user with the Administrator role can modify the controller name and the date of a measure in the main Creator
program, allowing the measurement session to be administrated retrospectively.
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Indicators

State of progress and summary

The Controller workshop interface presents two graphics providing dynamic information about the
state of progress of the checkings. At the end of each measurement session, summary indicators are displayed for
analysis and verification of checkings.

w Project analysis — m] X
X ¥
| Close  Validate
Action
Number of compliant parts: 4 Checkpoints Parts
| Number of defect parts: 1
| Number of defect checkpoints: 1 s . I:I I:I EI I:I I:I EI
3 Controiled: 4, NOK: 1
Part # Status Comments Serial #
+ 1 B
+ 2 B
+ 3 B
+ 4 =
Il=]- 8 (]
| Measured ... Deviation OK [ NOK Status Comments LWL LWL Machine Text 1 Text 2 Combo 1 (4 |
= 2013 [l ] = 2016 19.84
2021 [ il = 2016 19.84
= 53.24 5276
= 100.24 99.75999
v ] 0.09 0
4 »
+ 6 E
+ 7 E

Measurement deviation and min/max

New compliance indicators of measures are available in the measure tables of Creator and Controller. Minimum
and maximum measured values are displayed dynamically, together with a graphic showing the deviation between
dimensions and tolerances.

Part # Status Comments Serial #
R = TOP-180CX

Link | In.. Phase C. | .. Seco... Locati.. Acro_ | Value Fit Unit | Upp. tol... | Low.t.. | Low. wval. Upp.v.. Equipm.. Measured ... Deviation OK fMOK | Instrument 1 Status

1 - AE 100 mm | 03000 | -D3000 @ 997000 | 100.30_  Peda_ | 100,18 [ o | FAC2 =

2 /= 2 A5 53 mm | 03000 03000 527000 | 533000 | Thread_ 5286 [ m BF1 o)

3 - 2 B5 £ 15 03000 | -0.3000 | 147000 | 15.3000 1498 [ 1 | =

4 4 BE 20 mm 02000 | 02000 | 198000 | 202000 2012 | | | =

5 5 c7 35 mm | 03000 | 03000 347000 | 353000 | Microm_ | 35 [ 1 | MIC1 =

3 - s c2 0 h& mm | 00000 | 00160 | 399340 | 400000 Threed. | 3999122 || | TR =

7 - v A7 14 mm | 01000 00000 00000 | 01000 | Threed_ | D.085 | | TR =

8 - PPEP 00000 | 00000 | 0.0000 | 0.0000 ok v [

’ 9 - o 5 i3 mm | 00150 00150 49850 @ 50150 50153 [ =]
4 13

Reports from the Analyst program multi-criteria search

The results of a multi-criteria search in the Search tab of the Analyst program feed the data source for printing
reports. This makes it possible to exploit all data in customized reports.
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Interface

PPAP/DVI Excel export

A PPAP/DVI Excel template is available for exporting the control plan in the expected format of the industrial
substantiation file (DVI).

Impression documents

Home  Insert  Pagelayout  Formulas ew
m uD ., re
O BE e R « o [
New Open Save SaveAs Quick Print  Print  Undo Redo | Enayptwith Document
Preview Password  Properties
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Documents XLSX A 4 B c D E F [ H 1 3 K L M N o P Q
» | NeAticle - [ Numero de Type de Localisation de | Classification | Familedela | Numérode | Exigencedela | Unité (mm, | Exigence Exigence: [T+
Pzt B} o | siunseul | Caractéristique | caractéristique la dela é é é pouce, degrés | LIMITE INF. | LIMITE SUP.
o @ E PPAP pour (N° unique produit, procédé, gristi gristi < "D" Dim [ "P" pour les )
I Modele excel V2 = @ < N e N
= 3 T | plusieurs | didentification) matiére Standard | Procéds / "M | Matiéres ou
| o E E _| Aticles Safran mini | Fabrication / pour les
ocee 8 = @ & (famille de requis .« K»=| "H" Santé Procédés
| s S o 5| piéces clé; e N o= Matiére Spéciaux
. B & 2 S = | simples) Ou non clé -
Documents XLSM A £ = = 3 | assemblage e
@ o e G 1) classifications
@ g w
R S 2] optionnelles
= S e selon les
o £ ol sociétés du
3 & roupe
= 2 group
2 - - MBI 0 - 1 T 2 - 3~ - 5~ 6 - 7 - g - 9 - 0 -
24 1 50.1.-0,3/0,3 mm
5 2 25 -02/02 mm 248 252
2% 3 57 -0,3/0.3 mm 56,7 573
27 5 20 -0,2/0,2 mm 19.8 202
= 7 8 0202 mm 78 8.2
2 8 Rayon R R 40 -0,3/0.3 mm 397 40,3
| 30 9 22 -0.2/0.2 mm 218 222
| 3 10 16 -0,1/01 mm 15 1.7
32 11 16_-0,2/0.2 mm 15,8 16,2 .
W+ wi| Process Control | Dataproject  Datamease  + D »

New Excel export format

A new direct export format to Excel is available to facilitate communication with third-party software. It exports all
the properties of checkpoints and associated measures.

New Excel import format

In order to simplify communication with third-party software, CMM data can now be imported from CSV and TXT file
formats, in addition to the existing Excel format.
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TopSolid'Cam program time recovering

What's New in TopSolid'PartCosting 7.18

What's New in TopSolid'PartCosting 7.18

This chapter describes the new features of the TopSolid'PartCosting application in version 7.18 of TopSolid 7.

TopSolid'Cam and TopSolid'PartCosting communicate via Automation to use the precise times of an NC program
for quotation. At the TopSolid'PartCosting operation plan level, it is possible to link one or more machining

documents to retrieve operations, their precise times and the tools used.

7 BQE

& Home | L Equipment ¥ ]2D/3D 7| 4D/5D ¥ @ Tuming ¥ |k Grinding ¥ ] Additional ¥ | EOperation ¥ | ] Verify | ¥ G-Code Simulation |l Visualization ¥ YP"Analysis ¥ .- Construction ¥ | %

RPRER 'l 'achining 17 - TopSolid 7 (7.18.313.0-p4)
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hd = & 6: Drilling Machining 18 dmn A 0 ; 1 pgs% Mowt/umont 3 103
# Multiple geometry (2) '
=f 2 | 2% Orign 0,2 1 0,2
B\Agcsw [Origin1|C':0°:B:07] - 3 | 6% Conwl o5 1 o5
| 5 Il & 7: Drilling -
# Multiple geometry (2) D 4 1% Geaning 01 1 01
= Machining Stage ' ] s | 4% [1:Facng] -Ma. 033 1 033 =
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Copy of machining cycle elements

To facilitate management of the machining cycle, the Copy cycle element button allows selected elements to be

copied either from below each element (as before), or at the end of the cycle.

doyde | M Adi. /Proa.

;} E| | In.. % Pha.. Description Time | Qua.. Totalti.. Status . |op...
'} W 1 .5% Mount / unmount 3 i 3
2 | 2% Qrigin 0.2 1 0.2
‘? V| 3 l 6%  Control 0.5 i 0.5
[—E‘ | 4 1%  Cleaning 0.1 1 0.1
2 [1 5 4 as, [1:Fadng] -Ma.. 0.33 i 0.33 =
S# Copy under .
— [2: Fadng] -Ma... 0.12 i 0.12 B
g;.cowlm [3: Pocketing] -... 0.1 1 0.1 =
— [] 8 1%  [4:Pocketing] -... 0.08 1 0.08 =
a [] = § 7% [5:Drling] -Ma.. 147 1 1.47 =

|:| 10 ' 13%  [©: Driling] -Ma... 11 1 Li B

|:| 11 ' 17%  [7: Driling] -Ma... 1.48 1 148 B
Phase total

Caloulated time o |§| 8.4
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What's New in TopSolid'PartCosting 7.18

Ergonomics add-ins

Version 7.18 offers a set of new features to enhance the user experience in terms of software navigation and tools:

* total display in action windows;
* hiding unnecessary Material groups;
« display of a Total line in the list of profiles.

Software performance and fluidity improvement

A work about the loading time improvement of lists has been carried out and optimized regarding the Study
(parts list loading time) and Administrative (cases and estimates list loading time) module levels.
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